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Robotics is an exciting field to explore in the classroom and beyond.  Robots are 

involved in many aspects of life such as taking care of sick people, building cars, or 
providing entertainment in the form of toys. Future robotics applications include 
driverless cars and robotic companions who help people solve everyday problems.   

Introduction 
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In this curriculum you will learn and participate in the field of robotics through the lens 
of product development. Product development is the process of transforming 
great ideas into great products. There are thousands of companies across the globe that 
are product development companies. Can you think of some? If you named a company 
that creates human-made technologies you are right. Companies that make things as 
simple as a pair of jeans to as complex as an airplane are product development 
companies.  

 

Developing a robot requires important skills and knowledge. In this project you will have 
the opportunity to learn while also having fun with cool design challenges. In particular, 
you will have the opportunity to learn how to use 3D design software called PTC Creo, a 
software program that is used by thousands of product development companies across 
the globe including robotics companies such as iRobot or Boston Dynamics. You will 
also design and build robots with classroom-based kits and programs, which will require 
you to use your creativity, collaboration, and problem solving skills. Throughout this 
project you will learn how to design like the pros by using important industry strategies 
like optimization and brainstorming, to  name a few. We wish you luck as you explore 
the wonderful world of robotics! 
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Curriculum Details 
This beginner-level robotics curriculum is intended for secondary schools, grades 5-12 
in the United States.  This curriculum does not require prior knowledge in robotics or 3D 
modeling software. The curriculum is organized into two units: (1) Creo Foundations, 
and (2) Recon Robot Project. See details below.  

 

 
 

 

 
 

 

Creo Foundations 
 
Goal: Learn how to use 3D modeling 
software in the design of robots 
 
Core Robotics Skills: CAD, systems 
thinking, product development, simulation, 
mechanism, product analysis 
 
 
Modules: 6 
 
Resources: PTC Creo  
 
 
Learning Time: 18-20 hours 

 

Recon Robot Project 
 

Goal: Design an autonomous LEGO robot 
in a simulated disaster scenario 
 
Core Robotics Skills: CAD, programming, 
product development, design, 
brainstorming, sketching, modeling, 
marketing, communications, business  
 
Modules: 12 
 
Resources: PTC Creo, LEGO EV3 Kit, EV3 
Programming Software 
 
Learning Time: 24-30 hours 
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In robotics innovation, computer aided design - or CAD – is a key tool that 
enables designers to transform great ideas into great products.  

PTC Creo is used by robotics designers to create early prototypes, test new 
designs such as testing loads or assembly mechanisms, as well as for 
creating documentation that is incorporated in manufacturing and field 
support of robots in the field.  

The goal of this curriculum is to get you started in this innovative industry by 
providing you with cool projects and in-depth training that teaches you how 
to use CAD in robotics design.  

This chapter of the robotics curriculum includes approximately 18-20 hours 
of learning time.  

 

Creo Foundations 
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Curriculum Overview 
The curriculum begins with two introductory units (Solid Modeling for 
Robotics and Model Analysis & Simulation) focused on basic operations in 
PTC Creo, an industry-leading CAD software used by thousands of 
companies across the globe. After completing these two introductory units, 
you will delve deep into CAD-based design through the context of the four 
phases of product development.  

 
 

Concept Development 
The goal of this module is to use a systems-thinking 
approach to designing a robot. The module includes 
planning a robot design and activities for assembling a 
simple robot in PTC Creo Parametric. Estimated time: 3-
4 hours  
 
 

 
 

Detailed Design 
The goal of this module is to design a robot with moving 
parts. The module includes activities focused on 
creating mechanism assemblies in PTC Creo Parametric. 
Estimated time: 4-5 hours  
 

 
 

Production 
The goal of this module is to learn about the importance 
of documenting design decisions in product 
development. The module includes activities focused on 
creating exploded drawings and a bill of materials in 
PTC Creo Parametric. Estimated time: 3-4 hours 
 

 

Field Support 
The goal of this module is to create a field support plan 
for a robot. The module focuses on creating a failure 
modes and effect analysis (FMEA) plan, a common 
engineering strategy for supporting products in the 
field. Estimated time: 3-4 hours 
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Project Materials 
The Creo Foundations project requires 3D design software and associated files. These 
materials are provided free of charge by PTC Inc.  

 

Design Software & Files 

• PTC Creo Parametric: download at www.ptck12.com  
Cost: free 

• PTC Creo files: download at 
http://apps.ptc.com/schools/curriculum/Beginner_Digital_Robotics_KOP.zip  
Cost: free 

 

Software Requirements 

• Microsoft Windows operating system (if you have an Apple computer you can 
use Bootcamp or paralells to run Microsoft Windows operating system.  

• Updated graphics card (check your computer updates) 
• Minimum 3GB memory RAM  
• 3 button mouse 
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UNDERSTANDING HOW TO CREATE MODELS OF ROBOTS 
 

 

 

One of the greatest developments evolving out of the computer age is 
the development of 3-dimensional modeling of parts and products. This 
makes it easier for designers and engineers to create new parts and 
products. SOLID MODELING IS THE LANGUAGE OF PRODUCT 
DEVELOPMENT. When a company decides to develop a new product the 
ideas must be created as solid models in order for the ideas to become 
real products.  

Since solid modeling is the language of product development it is 
important to learn how to use it to express new ideas. So let’s get started! 

 

Module 1: Solid Modeling for Robotics 
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Exercise 1: Exploring Models of Products 

Let’s start by opening a model of a deep sea submarine and exploring the 
parts and procedures of a solid model. 

1. Start PTC Creo Parametric by 
double-clicking on the icon or 
by going to the Start Menu, 
finding PTC Creo Parametric, 
and selecting it. 

       

2. From the Home tab, Data group, 
click Select Working Directory

. 

This allows you to set the folder 
that PTC Creo Parametric will use 
to open and save files. 

 

3. Navigate to the Digital 
Robotics  folder: 

• Double-click the 
Deep_Sea_Sub folder. 

• Click OK. 

 

12



4. From the Home tab, click Open 

:  

• Double-click 
deep_sea_sub.asm 

 

5. You now have the deep sea 
sub model open in Creo. 

 
 

3D solid models are mathematical models of real or virtual parts and 
products. In this section, we will look at the anatomy and elements of 
solid models, explore how solid models are organized, and introduce you 
to the solid modeling tool “PTC Creo.” Before you begin to develop a 
model, it is important to understand what 3D solid models consist of and 
how they are constructed. 

Characteristics of a Solid Model 
3D solid models are constructed by adding and subtracting geometric 
volumes to create the final shape of a part or product. This use of “sums” 
of geometry has become a language for representing ideas for new parts 
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and products. Let’s begin by exploring the anatomy – or elements – of a 
solid model. 

Model Anatomy 
A solid model is really a sophisticated mathematical set of equations 
represented in software; however, you hardly ever have to work with 
those equations. You are able to create and modify solid models simply 
by working with two representations of the model: a procedural 
representation and a graphical representation. 

The procedural representation is like a list of instructions, which will 
produce the solid model when followed. It is called a “Model Tree.” It 
doesn’t look much like a tree in this view because it is just a list. However, 
when we graph the procedural representation with respect to 
dependencies, it becomes a “tree” graph.  
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6. In the model tree, notice the 
procedural representation of 
the model. 

 

Notice that there are three sections to 
the model tree. The tree begins at the 
top with datums (coordinate systems & 
planes) that are important to the model. 
Next is the list of all of the parts in the 
model. The model is sort of like a big 
sum of all of the parts. Finally, there is 
the insert location which is the place 
where a new part can be added. It turns 
out that the order in which things are 
added is important.  

The graphical representation is what 
the solid model looks like. That is easy to understand. You will use both of 
these representations when building or modifying solid models. 

Coordinate Systems 
All geometry is built in reference to a global coordinate 
system. It is usually referred to as the “origin.” This is 
simply a point in space that is recognized as the 
starting point or (0,0,0) location. This point is usually represented by three 
crossing lines as shown. Product models may have several origins, one for 
each part in the assembly.  
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There are also other types of references that are used in solid models such 
as planes, axes, and points. All of these references are called datums and 

are typically referred to as 
“datum planes, datum points, 
and datum axes.” 

A default set of datums 
includes the origin coordinate 
system and the three 
coordinate planes (FRONT: X-
Z, RIGHT: Y-Z, TOP: X-Y). Axes 
can be defined at the 
intersection of any two of 
these planes. 

Carefully selecting what 
datums you use as references for creating geometry will ensure that your 
model is robust (i.e. doesn’t break or fail) and helps ensure that you will 
be able to create all the different aspects of your model as easily as 
possible. We’ll show you how to plan these datums and references later 
and also show you how to create them in PTC Creo. 

7. In the graphics area, notice the datum 
planes, coordinate systems, and spin 
center are displayed in the model. 
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8. From the In Graphics toolbar: 

• Click Datum Display Filters  
and disable the display of all 
datum features 

 

9. The graphical display of the submarine 
should now be easier to see since the 
datums are no longer displayed. 

 

 

The Art of Solid Modeling 
PTC Creo is a suite of tools that helps you build 3D models. One of the 
tools that we will use to create solid models is called PTC Creo Parametric. 
PTC Creo Parametric is like a virtual art studio where you can build 3D 
solid models.  

It can be helpful to think of PTC Creo Parametric as a virtual studio made 
up of different rooms as shown below. There are many different modes or 
rooms within PTC Creo Parametric where different functions can be 
completed. Within each of the modes, the tool sets are different. Moving 
from one mode to another is an important part of PTC Creo Parametric.  
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When creating part and assembly models, we will use the 3D Part 
Modeling mode and the 3D Assembly mode. We will also use a 2D Sketch 
mode in order to create features. Later on we will explore some of the 
other capabilities.  

The other unique aspect of PTC Creo Parametric is the amount of user 
interaction that is required in creating geometry. When you think about 
how you would use your hands, fingers, and all types of tools if you were 
creating or sculpting in an art studio, you can understand why it requires 
so much user interaction in creating geometry. Because PTC Creo 
Parametric is software, the only means of user interaction is through the 
buttons and motion of the mouse and keyboard. You will find that you 
will use more buttons and button combinations in interacting with PTC 
Creo than probably any other program you have used. 

 

18



Tour of the PTC Creo Screen 
Before we start working in PTC Creo Parametric we should take some 
time to understand the user interface and methods to navigate and view 
models.  

 

The PTC Creo Parametric user interface is the now familiar Windows 
Ribbon environment. The Windows Ribbon makes it easy to navigate 
functions arranged in tabs and groups.  The different parts of the main 
ribbon are shown below.  Take some time to familiarize yourself with the 
various menus as these will be used throughout this modeling activity.  
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Orienting the View in Creo Parametric 
PTC Creo Parametric offers easy-to-manipulate model views so that 
engineers can view their designs from different perspectives. 

Rotate 

Hold down the 
middle mouse 
button and move 
the mouse.  

Middle-Hold + Drag 

 

 
 

Zoom 
in/out 

Use the middle 
mouse button to 
scroll forward or 
backward. 
To zoom into a 
specific location of 
your model, move 
your mouse to that 
location before 
scrolling the mouse 
wheel. 

  Middle-Scroll:  
  Forward = Out 
  Backward = In 

 

Pan 

Hold Shift, then 
press and hold the 
middle mouse 
button. Moving the 
mouse will then pan 
the view. 

Shift + Middle-Hold + Drag 
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Display Options in Creo Parametric 
PTC Creo Parametric also has a number of predefined display settings and 
views to help you visualize your design. 

Refit 
Window 

Click to refit your model in the main graphics area. If 
you somehow “lose” the graphic display of your 
model, clicking this button will usually get it back for 
you.   

Named 
Views 
 

Creo Parametric has a number of pre-defined saved 
views which enable you to view your model in 
different orientations such as BACK, BOTTOM, FRONT, 
and TOP. 
 

 

 

Datum 
Display 

The display of datum features can be 
toggled on and off from the datum display 
toolbar. 

 

Planes  
 

Axes  
 

Points 
 

Coordinate 
Systems 

 

 

Model 
Display 

The display of your model can be quickly 
set from the model display toolbar. 

 

Wireframe 
 

Hidden Line 
 

No Hidden 
 

Shading 
 

Shading With 
Reflections 

 

 

 

This was a brief introduction to the PTC Creo Parametric User Interface. As 
you progress through this activity you will explore and use many more 
functions within PTC Creo Parametric. 
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10. Move your cursor over the 
center of the sub and then: 

• Roll the middle-mouse 
wheel away from you to 
zoom out. 

• Roll the middle-mouse 
wheel towards you to zoom 
in. 

Creo zooms in or out from the 
location of your cursor when you 
roll the mouse wheel. To zoom 
in near your sub’s engines, move 
your cursor there before rolling 
the mouse wheel.           

 

 

11. Hold down the middle-mouse 
wheel and drag your mouse to 
spin the sub. 
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12. Hold down the SHIFT key and 
middle-mouse wheel while you 
drag your mouse to move or 
“pan” your model. 

  

13. When there are parts of the 
model that can move – like the 
arms, lights, and engines of the 
sub – press and hold down the 
CTRL and ALT keys while left-
clicking and dragging the parts to 
move them. 

 

 

 

  

23



Sum of Parts 
When modeling a product or assembly, most of the model tree consists of 
a list of parts. These parts can be single parts or sub-assemblies of parts 
(sort of like a model inside of a model). This means that there are 
relationships between the parts in the list. All of the parts in a model are 
the children of that model. The top-level model is the parent. These 
relationships are referred to as Parent-Child relationships and represent 
which models own what parts.  

It is these types of relationships that turn the model tree from a list into a 
tree. These relationships will become important to you as you build your 
own models. 

14. To the left of the graphics 
display, locate the Model Tree. 

15. Identify the three parts: Datums, 
Parts, and Insert Here location. 
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16. Place the cursor over the 
BODY.ASM component in the 
model tree and notice that it 
causes the graphic model of the 
body to be highlighted.  

You can explore each of the 
parts in the product model this 
way. Notice that if you place the 
cursor on the graphical model, 
the parts will highlight and the 
corresponding entries in the 
model tree will be underlined.  

17. In the model tree, right-click on BODY.ASM and 
select Open from the pop-up menu. 

To open a pop-up menu, you must select 
something and then hold down your right-mouse 
button. 
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You have opened the part 
model of the body of the Deep 
Sea Submarine. You can see 
that the model tree only 
includes the parts that make up 
the body. 

 

18. From the Schools tab, Models group, 

click on  Windows: 

• Notice that you now have two 
windows open and that the 
BODY.ASM window is the active 
one since it has a check mark by it. 

This is how you manage multiple 
models when you have more than one 
window open. The view tab allows you 
to switch between windows or models. 
The check mark indicates which window 
is active. You can only make changes to 
a model in the active window. 

 

19. In the Model Tree, left click the gray 
triangle  next to INNER_SPHERE.prt 
to see a list of its features.  
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Sum of Features 
So far we have talked about how models of products or assembly models 
are made up of a collection of parts. What about the model of a single 
part? It isn’t a collection of parts; instead it is a collection of geometric 
features. 

 

Geometric features are “chunks” of geometry that make up the model of 
the part. If we look at the model tree of a part model we will see these 
features.  

Part models are different from assemblies or models of products 
(collections of parts). Part models can have positive and negative features. 
The features – or chunks of geometry – can add solid geometry or can 
subtract solid geometry.  
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20. From Schools tab, click  Close to close the 
model of the body. 

 
 

Display Styles 
There are several different display styles that you can use to better 
explore your models. These display styles allow you to show the model as 
a solid or an outline where only the edges are displayed. Try each of these 
styles so that you are familiar with them. It is also possible to change the 
colors of the model. 

21. From the In-Graphics toolbar, 
click  Display Style. 

Notice that there are six different 
display styles for the graphical 
representation of the model.  

22. Try each of the styles and see 
how it changes the model 
display. 

23. Choose whichever display style 
you prefer to work with. 
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24. From the Schools tab, Display 
group, click the drop-down 

menu under  Appearance 
Gallery.  

25. Select a color and then left-click 
on the part you wish to change 
to that color.  

In an assembly model you can 
only change the color of an 
entire part. If you want to 
change the color of a portion of 
a part, then you must open the 
part model and make the 
changes in that new window. 

 

26. In the Select dialog box in the 
upper-right corner of your 
screen, click OK.  

Notice that the color of the part 
you selected has been entirely 
changed.  

If you want to change the color 
of different portions of a part 
you must open the part model.  
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27. From the Schools tab, click  Close to 
close the Deep Sea Sub. 

28. From the Home tab, Data group, click 
 Erase Not Displayed. Click OK to 

clear the session from memory. 

This clears the assembly model and parts 
models from the internal memory of the 
computer so that you can open new 
models. 

All of the files are still in the folders on 
your computer.  

 

Review 
So let’s review; there are two types of solid models: an assembly model, 
which is a collection of part models for modeling products, and part 
models, which are collections of positive and negative chunks of 
geometry called features. 

There are two types of representations for these models: procedural 
(model tree) and graphical. We will use both in creating and modifying 
these models. 

There are references used in the creation of the models called datums. 
These consist of coordinate systems, datum points, datum planes, and 
datum axes. 

PTC Creo Parametric is like a virtual art studio with different rooms that 
correspond to the different modes within PTC Creo Parametric for doing 
sketches, 3D modeling, assembly, etc. 

You use your mouse to orient models in PTC Creo Parametric. Scrolling 
the middle mouse wheel zooms in and out of the model. Pressing down 
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the middle mouse button and moving the mouse rotates the model. 
Pressing the Shift key while holding down the middle mouse button and 
moving the mouse pans the view. 

Before we move on, let’s review what we did with the Deep Sea Sub: 

1. Set the Working Directory (Steps 2-3)  
2. Opened the assembly model (Step 4) 
3. Turned off the datum displays (Step 8) 
4. Zoomed, rotated, and panned the model (Steps 10-13) 
5. Moved the arms of the deep sea sub (Step 13) 
6. Used the model tree to highlight each part in the assembly (Step 

16) 
7. Opened one of the part models (Step 17) 
8. Closed the part model (Step 20) 
9. Changed the display style of the graphic representation (Step 21) 
10. Change the color of a single part (Steps 24-26) 
11. Closed the sub and erased the session from memory (Steps 27-28) 

 
Congratulations! You have completed this module. 
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USING MODELS TO UNDERSTAND FORCES, MOTION, & PROPERTIES 
 

 

 

Model Analysis 
When products are being developed in a product development process, a 
necessary step is to predict how they will perform in the real world. One 
of the objectives in building models of parts and products in PTC Creo is 
to discover how they might function in the real world, BEFORE they are 
actually built. Once a model has been created, it can be interrogated to 
learn length, width, surface area, volume, angles, diameters, etc. These 
types of measurements help designers determine whether their proposed 
designs will fit in a given location, will be too heavy or too light, or will 
cost too much. 

Let’s get started looking at measurements in PTC Creo. 

Module 2: Model Analysis & Simulation 
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29. Start PTC Creo Parametric 
by double-clicking on the 
icon or by going to the Start 
Menu, finding PTC Creo 
Parametric, and selecting it. 

         

30. From the Home tab, Data 
group, click Select Working 

Directory . 
 

Remember that this allows you 
to set the folder that PTC Creo 
Parametric will use to open and 
save files. 

 

31. Navigate to your Digital 
Robotics folder: 

• Double-click the 
Ornithopter folder. 

• Click OK. 
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32. From the Home tab, click Open 

:  

• Double-click 
top_level_assembly.asm. 

 

33. Notice that the datum 
planes are displayed. 

34. In the model tree, 
notice the procedural 
representation of the 
model. 

 

35. From the In Graphics 
toolbar: 

• Click Datum Display 

Filters  and disable 
the display of all datum 
features.  

This is a model of Da 
Vinci’s Ornithopter. 

 
 

 If the model of the Ornithopter were to be made of wood, it would be 
helpful to know how much total wood would be required to determine 
the cost of the final kit. PTC Creo can calculate the total volume of an 
assembly like this very quickly. 
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36. From the Analysis tab, 

Measure group, click  
Measure.  

 

37. In the Measure dialog box, 

select  Volume.   

38. Select the entire assembly by left clicking on 
TOP_LEVEL_ASSEMBLY.ASM in the Model 
Tree. 

 

39. The total volume of the 
Ornithopter will now be 
displayed.  

 
 

If each part was made out of the same type of wood, the cost of the entire 
kit of materials would then be: 

 Total Cost = (45.2584 in3)*(Price of Wood $/in3) 

This is very useful for predicting the cost of manufacturing products. It is 
also possible to determine length, width, diameter, angle, etc. Let’s try 
measuring some of these values. 
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40. From the Measure dialog 

box, click  Length.   

41. Measure the length of one of 
the edges in the Ornithopter 
by left-clicking on it as 
shown.  

 

42. From the Measure dialog 

box, click  Angle.   

43. To measure the angle 
between two edges, left-click 
on the first edge and then 
press and hold the CTRL key 
while left-clicking the second 
edge. 

 

44. From the Measure dialog box, click 

 Diameter.   

45. Left-click on the outer edge of one 
of the gears to measure its 
diameter. 
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46. From the Measure 

dialog box, click  
Area.   

47. Left-click on a flat surface 
to measure surface area. 

 

48. Close the Measure dialog box by 
clicking the X in the upper right-
hand corner.  

 

There are other properties that are important in understanding how a 
product will behave in the real world. For example, the center of gravity of 
a product represents the point at which all its mass seems to be acting. 
This is important for tipping studies. If the center of gravity is too high 
with respect to the overall shape of the product, there may be a chance 
that the product will tip over. PTC Creo can calculate the center of gravity 
of a model mathematically.  
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It is very difficult to calculate the center of gravity without a computer 
model even if you were to build it out of real materials. 

There are other properties that are related to the mass of the product and 
are therefore called “mass properties.” These include volume, weight, 
moments of inertia, etc. All of these can be calculated for a given part or 
assembly. 

 

49. From the Analysis tab, Measure 

group, select  Mass 
Properties.  

 

50. In the Mass Properties dialog box, click Preview. 
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Notice that the volume, 
surface area, average 
density and mass have 
all been calculated. You 
can scroll down to see 
the other properties. 
Note that the center of 
gravity is displayed as a 
coordinate system in 
the graphics area.  

51. Click OK to close the Mass Properties dialog box.  

 
 

 

 

 

 

 

 

39



All of these mass properties depend on the material you will use to make 
the parts. Therefore, it is easy to explore the differences by changing the 
materials. This can be helpful in determining which materials to use when 
building the product. 

Units become important as well. It is easy to translate a model from one 
set of units to another. 

52. From the File tab, select Prepare, and 

then click  Model Properties.  

 

53. From the Model 
Properties dialog box, 
click change next to Units.  

 

The Units Manager dialog box will allow you to 
change the units of your model. For now we’ll keep 
the original units.   

54. Click Close in the Units Manager dialog box and 
Close the Model Properties. 
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Simulation of the Real World 
Now that we are able to measure the shape and size as well as the mass 
properties of a product, we can simulate how the product will behave in 
the real world. To simulate, we need to move to a different mode within 
PTC Creo Parametric. 

55. From the Schools tab, click 

 Mechanism. 

This moves you into the 
mechanism mode which is a 
virtual laboratory where you 
can perform different 
experiments with the model. 

 

Notice that new symbols 
appear on the model that 
represent motion joints 
and gear connections. 
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There is a new part to the Model Tree called the 
Mechanism Tree. This contains all of the elements 
you will need to do simulations. 

56. In the Mechanism Tree, expand ANALYSES by 
clicking on the gray arrow next to it.  

57. Right-click  Wing_Flapping (KINEMATICS) and 
select Run. 

This will start the simulation and PTC Creo Parametric 
will calculate all the positions for the flapping of the 
wings. 

 

58. Once the simulation is complete, expand the 
PLAYBACKS. 

59. Right-click  Wing_Flapping and select Play.  
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Collecting Data 
Now that you have calculated a simulation of the wings flapping, it will be 
valuable to collect data that can be used to analyze the motion of the 
wings in terms of position, velocity and acceleration. Fortunately, since the 
simulation was done in the computer, it is possible to take data at any 
point on the model. 

 

60. In the Animate dialog box, click Play to start 
the animation and use the slider to speed up 
or slow down the playback.  

You can also capture the simulation as a video 
using the Capture button so that it can be 
played outside of PTC Creo. 

61. Click Close.  

  

62. From the Mechanism 
tab, Analysis group, 

select  Measures. 
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63. In the Measure Results dialog box, 

click  Create new measure. 

 

64. In the Measure 
Definition dialog 
box, change the 
name to Position. 

65. Left-click on a point 
at the end of the 
wing as shown and 
click OK. 
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66. Create another measure by clicking on   
Create new measure again and then changing 
the name to Velocity.  

67. In the drop-down menu under Position, change 
the type to Velocity. 

68. Left-click on the same point on the end of the 
wing and click OK. 

 

69. Repeat steps 66-68 to create a measure 
called Acceleration and change the type to 
Acceleration. 

70. Click on the same point on the end of the 
wing and then click OK. 
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71. In the Measure Results dialog box, select all three data 
measures by holding down the CTRL key and left-clicking 
on all three. 

72. Under Result set, left-click on Wing-Flapping to select it. 

 

73. Click  Graph in 
the upper part of 
the Measure 
Results dialog box 
to see the results. 
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74. Close the Measure 
Results dialog box. 

Keep the Graphtool open 
while closing the dialog 
box. 

 

75. In the Mechanism Tree, right-click on 

 Wing_Flapping under 
PLAYBACKS and select Play. 

76. Use the buttons in the Animate 
dialog box to play the animation. A 
red bar shows the location in the plot 
of the data. 

 
 

 

77. Close all of the dialog boxes and select Don’t Save to exit 
out of Mechanism mode. 

78. From the Schools tab, click  Close to close the 
Ornithopter. 

79. From the Home tab, Data group, click  Erase Not 
Displayed. Click OK to clear the session from memory. 
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Review 
Let’s review what we have been able to do with the Ornithopter model: 

1. Measured the total volume, lengths, angles, diameter, and surface 
area of parts in the model (Steps 36-48) 

2. Calculated the mass properties and center of gravity of the model 
(Steps 49-51) 

3. Learned how to change the units of the model (Steps 52-54) 
4. Simulated motion of the wings flapping by running a simulation 

(Steps 55-61) 
5. Collected data from the simulation and graphed it (Steps 62-76) 

 

These measurements, simulations, and data collection are very powerful 
tools that help designers create new products. 

 

Congratulations! You have completed this module. 
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CREATING A PLAN FOR YOUR ROBOT DESIGN 

 

 

Systems thinking in conceptual development 
The conceptual development phase is when great ideas are transformed 
into initial concepts and prototypes. This process can start with napkin 
sketches of ideas and evolve to more complex prototypes such as 3D 
digital models.  

An essential step in conceptual development is identifying the plan for 
developing the product. In robotics product development this step 
requires that you identify all of the sub-systems that will make up your 
robot. This might include the drive train, the motors, the control unit, and 
the bucket, or it may include different sub-systems depending upon the 
type of robot you are designing. 

Module 3: Conceptual Design 

49



 

Creating Sub-assemblies 
An important part of modeling products is to determine the sub-systems 
that make up the product and the corresponding sub-assembly models. 
This can often be represented using tree graphs. 

 

Here is an example tree graph of the PTC robot showing the various sub-
systems that make up the robot. Each of the sub-systems can be modeled 
as a separate assembly model within PTC Creo. 
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A conceptual design of your robot can be created by sketching a tree 
graph of all of the sub-systems. This graph can be a plan for how to 
create a 3D model of your robot. 

The different sub-systems will depend upon what your robot is supposed 
to do. For example, if your robot is supposed to grasp a ball, then you will 
have an arm and grasper sub-systems instead of a bucket. 

Determining what will be in your robot is an important step in designing 
your robot. Sketches of the tree graph shown above are part of your 
conceptual design. 

Assembling Parts in PTC Creo 
Once you have defined your robot system, you can begin building each of 
the sub-systems so that eventually you can combine them into a 
complete model of your robot. 

Defining how parts come together in an assembly 
requires the application of constraints that reduce 
the degrees of freedom of a part. There are 6 
degrees of freedom for any given part.  Three of 
these degrees follow the translation axes and they 
are forward to back, side to side, and up and down 
movement.  The other three follow rotation axes 
and rotate around the X, Y, and Z axes.  

Constraints are applied to reduce the degrees of freedom so that parts 
are oriented to each other in the appropriate ways. It’s easier to 
understand as you do it, so let’s get started.  

We’ll begin by applying some basic constraints to an easy model and then 
move on to more complex examples. The process of assembling product 
models is called system integration and is an important part of product 
development. 
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80. Start PTC Creo Parametric by 
double-clicking on the icon or 
by going to the Start Menu, 
finding PTC Creo Parametric, 
and selecting it. 

         

81. From the Home tab, Data 
group, click Select Working 

Directory . 
 
Remember that this allows you 
to set the folder that PTC Creo 
Parametric will use to open and 
save files. 

 

82. Navigate to your Digital 
Robotics folder: 

• Double-click the 
Peg_Block_Assembly 
folder. 

• Click OK. 
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83. From the Home tab, click New : 

• Change the type of file to 
Assembly. 

• Type in “Peg_assembly” for 
the file name. 

• Click OK. 

 

84. From the In Graphics toolbar: 

• Click Datum Display Filters  and 
disable the display of all datum 
features.  

 

85. From the Schools tab, Assembly group, click 

 Assemble.  
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86. Select assembly_block.prt 
and click Open. 

 

The part will follow your cursor 
until you drop it in the Graphics 
Area.  

87. Left-click anywhere in the 
Graphics Area to drop the part. 

The Orientation Sphere helps 
you reposition a part once you 
have dropped it.  

The first part in an assembly 
doesn’t have any other parts to 
reference, so it needs to be 
locked to the origin. 

88. From the Automatic pull-down 
menu, choose Default. 

Default locks the model to the 
origin.  If the first part is not 
placed as default, then any 
kinematic constraints will not 
function properly. 
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Notice that the part has changed 
color, the orientation sphere has 
disappeared, and it has the “STATUS” 
of Fully Constrained. 

89. Click the green checkmark  to 
complete the placement of the 
component. 

 
 

Now that the first part is in place, we can assemble other parts to it. If we 
were to assemble a peg into one of the holes in the block, it is intuitive 
that we would insert it into the hole until it comes to rest. On a computer, 
this is less intuitive. We need to place constraints on the peg until it 
comes to rest with the right placement. 

 

The first constraint we would use is to make the axes of the peg and the 
hole coincident so they would line up.  You can think of coincident as 
another word for “touching.”  Next, we would need to make the underside 
of the head of the peg coincident with the top of the block. 
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Assigning assembly constraints consists of selecting two surfaces at a 
time. The first assembly constraint in this case requires us to select the 
cylinder of the peg and the inside cylinder of the hole. PTC Creo interprets 
the selection of those two surfaces as a coincident constraint and aligns 
the axes. 

The second assembly constraint involves selecting the underside of the 
head of the peg and the top of the block. Once again, PTC Creo interprets 
that to be a coincident constraint and aligns the flat surfaces. 

Let’s do this in PTC Creo so you can see it happen. 

90. Click  Assemble:  

• Select assembly_peg.prt. 
• Click Open. 

91. In the graphics area, click to place the 
peg above your block as shown.  

 

92. In the ribbon, click the 
Placement tab to open it.  
 
The Placement tab documents 
the constraints as you create 
them. It also allows you to edit 
the constraints if you want to 
change them. 

 
 

The next step is to select two appropriate surfaces to create a constraint. 
PTC Creo helps by highlighting the surfaces your cursor is on so that you 
know what surface would be selected if you were to left-click. 
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It is important to note that each click of the mouse tells PTC Creo to use a 
new surface to make a constraint. You need to be careful not to click 
unnecessarily. Only click to select the appropriate two surfaces. 

 

93. If necessary, zoom in on the peg.  

94. Place your cursor on the cylinder 
of the peg and left-click once to 
select it as shown.  
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95. Hold SHIFT, middle-
click, and drag to pan 
your model until you 
can see your block.  

96. Place your cursor on 
the blue cylindrical 
surface of the block and 
left-click once to select 
it. 

You will notice that the 
axes align 
automatically. 

 

Notice that there is now a 
coincident constraint 
under the Placement tab 
with two surfaces listed 
underneath it. 

 

Also notice that four of the degrees of 
freedom have been grayed out, indicating 
that there are only two degrees left: up and 
down (the green arrow), and rotation (the 
green arc). 
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97. Middle-click and drag to rotate 
your model so you can see the 
underside of the peg.  

98. Left-click on the flat bottom 
surface to select it. 

 

99. Rotate your model again so you can 
see the top of the block.  

100. Left-click on the top yellow 
surface to select it. 
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Notice that initially PTC 
Creo defines a Distance 
constraint between the peg 
and the block. We need a 
Coincident constraint. 

101. Under the Placement 
tab, open the drop-down 
menu next to Distance and 

select  Coincident.   

102. Click Complete Component

. 

 
 

Congratulations! You have successfully assembled your first two parts.  

From the Quick Access Toolbar, click  Close to 
close the Peg Assembly. 

From the Home tab, Data group, click  Erase Not 
Displayed.  

Click OK to clear the session from memory. 
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Practice Creating Sub-assemblies 
Now it’s time for you to practice creating sub-assemblies. For the sample 
FTC robot shown below, finish filling out the tree graph showing all of the 
sub-assemblies involved. Don’t forget that each sub-assembly can be 
further broken down into more sub-systems.. There is a video of the FTC 
Robot’s movement in the STARBASE Robotics folder. 

 

Congratulations! You have completed this module. 
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ASSEMBLING MOVING ROBOT COMPONENTS 

 

 

In the detailed design phase the objective is to create a final product that 
is ready for manufacturing. This requires a number of steps such as 
detailed modeling, testing, and optimization. 

In this phase, 3D modeling software like PTC Creo enables robotics 
designers to quickly assemble the final product and prepare for it 
documentation that is used by manufacturers in the Production phase.  

In this module we will focus on assembling the drivetrain mechanism. The 
drivetrain allows the robot to move and consists of the frame, the wheel 
sub-system and the gear sub-system. 

 
 

Module 4: Detailed Design 
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What is a Mechanism? 
A mechanism is created when multiple kinematic elements are combined 
to create a machine that provides some desired motion or mechanical 
advantage. In the diagram below you can see multiple kinematic elements 
that have been combined to create a crank and slider mechanism. This 
mechanism converts rotary motion into linear motion with a slight 
mechanical advantage. 

 

Since it is possible to create kinematic joints in PTC Creo, mechanisms can 
be created by combining multiple joints. There is a specific application 
within PTC Creo dedicated to creating mechanisms. 

Let’s begin by creating the drivetrain for your robot and defining gear 
pairs so that the wheels turn appropriately. 
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103. Start PTC Creo Parametric 
by double-clicking on the icon 
or by going to the Start Menu, 
finding PTC Creo Parametric, 
and selecting it. 

         

104. From the Home tab, Data group, 

click Select Working Directory . 
 

Remember that this allows you to set 
the folder that PTC Creo Parametric will 
use to open and save files.  

105. Navigate to your Digital 
Robotics  folder: 

• Double-click the 
PTC_Robot folder. 

• Click OK. 
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106. From the Home tab, click New : 

• Change the type of file to Assembly. 
• Type in “Mydrivetrain” for the file name. 

107. Click OK. 

 

108. From the In Graphics toolbar: 

• Click Datum Display Filters  and 
disable the display of all datum 
features.  

 

109. From the Schools tab, Assembly group, 

click  Assemble.  
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110. Select channel-288mm.prt 
and click Open.  

 

111. Left-click anywhere in the Graphics Area to drop the part. 

The Orientation Sphere helps you reposition a part once you have 
dropped it. 

 

112. From the Automatic pull-down 
menu, choose Default. 

113. Click the green checkmark  
to complete the placement of the 
component. 

Remember that Default locks the 
model to the origin.  If the first part is 
not placed as default, then any 
kinematic constraints will not function 
properl 
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114. From the Schools tab, click  
Assemble. 

115. Select axle-bronze_bushing.prt 
and click Open. 

116. Left-click to drop the bushing next 
to the middle hole on the channel.  

 

We’re going to assemble this 
first bushing into the middle 
hole on the side of the 
channel. 

117. For the first constraint, 
select the cylindrical surface 
on the bushing and the 
surface of the middle hole as 
shown.  
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118. Rotate your model and select 
the flat surface on the bottom of 
the head of the bushing as shown.  

 

119. Left-click on the flat 
side of the channel. 

Make sure that Creo uses 
Coincident constraints to 
place the bushing in the 
hole.  

120. Click the green 

checkmark  to 
complete the placement.  
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121. From the Model Tree, right-
click AXLE-
BRONZE_BUSHING.PRT and 

select  Repeat from the pop-
up menu.   

The Repeat tool will save us work 
when assembling the remaining 
bushings.  

 

122. In the Repeat Component dialog box, hold CTRL 
and left-click on the two Coincident constraints.  

123. Click Add.  
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124. Left-click on the inner 
surface of a hole that is 5 
spaces away from the middle 
as shown.  

 

125. Left-click on the side of 
the channel to complete the 
placement of the bushing.  

 

126. Place 4 more 
bushings in the channel 
to match the image to 
the right.   

You’ll have to rotate and 
zoom the model to place 
the bushings on the 
opposite side. 

127. In the Repeat 
Component dialog box, 
click OK to add the 
bushings to the assembly. 
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128. Bring large_gear_sub.asm into the 
assembly and drop it next to the channel.  

129. From the User Defined drop-down menu, 
select Pin.  

A pin constraint will allow the gear to spin in 
the hole.  
 

 

130. Use your knowledge of Pin 
constraints to assemble the 
gear into the middle set of 
bushings as shown. 

Make sure the spacer on the 
back of the gear is coincident 
to the face of the bushing.   
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131. Use two more Pin 
constraints to add the 
wheels (wheel_large-
sub.asm) on either side 
of the gear.  

 

 

132. Rotate your assembly so 
that you can see the gear 
teeth. 

133. Use the CTRL + ALT 
keys to rotate the two outer 
wheels and ensure the gears 
mesh correctly. 

 
 

Now we will move into a new application of PTC Creo called “Mechanism.” 
This area of PTC Creo provides tools for creating and simulating 
mechanisms. 

134. From the Schools tab, 

click  Mechanism. 

 

135. From the Mechanism tab, 

select  Gears.  

 
 

72



A gear pair tells PTC Creo that two pin joints are connected in a specific 
way. Typically, this relationship is defined by a ratio. For example, when 
two gears connect, there is a gear ratio that relates the diameters of the 
two gears or the number of teeth on each gear. 

136. Left-click on the orange motion axis 
of the large gear.  

 

137. From the Gear Pair Definition dialog 
box, select the Gear2 tab. 

138. Left-click on one of the orange 
motion axes of the wheels. 
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139. Select the Properties tab. 

140. From the Gear Ratio pull-down menu, select User 
defined. 

141. Set the ratio to 120:80 based upon the number of 
teeth of the two gears. 

142. Click OK. 

 

143. Repeat steps 133-141 to 
create a gear pair between the 
large gear and the other 
wheel. 

You can test the gear pairs by 
holding the CTRL + ALT keys, 
left-clicking on one of the 
wheels, and turning it to see 
that everything rotates 
correctly.  
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If the rotation is not correct, you may need 
to flip the direction of the gear pair. 

144. If necessary, expand Connections in 
the Mechanism Tree. 

145. Expand Gears, right-click on the 
appropriate Gearpair, and select Edit 
definition.  

146. In the Gear Pair Definition dialog box, 
click on the Gear2 tab and use the Flip tool 

 to change the direction of the gear 
pair. 

 

147. Select File>Save to save your model. Click OK.  

148. From the Schools tab, click  Close to close the Drivetrain. 

 

Congratulations! You just finished building the drivetrain sub-assembly. 
The power sub-system and bucket sub-system have already been created 
for you. Let’s move on to assembling all of the sub-assemblies together to 
create our finished robot.  

149. From the Home tab, click New : 

• Change the type of file to Assembly. 
• Type in “My_Robot” for the file name. 

150. Click OK. 
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151. From the Schools tab, Assembly group, 

click  Assemble.  

 

152. Select power_sub.asm 
and click Open.  

 

153. Left-click anywhere in the 
Graphics Area to drop the power 
sub-system. 
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154. From the Automatic pull-down 
menu, choose Default. 

155. Click the green checkmark  
to complete the placement of the 
component. 

 

156. From the Schools tab, click  
Assemble. 

157. Select mydrivetrain.asm and 
click Open. 

158. Left-click to drop the drivetrain 
next to the power sub-system.  

159. Left-click and drag the arrows and 
arcs of the Orientation Sphere to line 
the drivetrain up as shown.  
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160. Left-click on the two 
surfaces shown to align 
the holes.   

 

161. Left-click on the flat 
side of the channel and 
the end of the power 
system to align them.  

If necessary, change the 
constraint type to 
Coincident.  
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162. Left-click on the flat 
top of the drivetrain 
channel.  

163. Rotate the model, 
and select the bottom 
surface of the power 
system channel. 

164. Click the green 

checkmark  to 
complete the placement. 

 
 

 

Now that the first drivetrain sub-system is in 
place, we can add the other one.  

165. Click  Assemble, then select 
mydrivetrain.asm and place it next to the 
power sub-system.  

166. In the Ribbon, select  Place Manually.  

167. Use the Orientation Sphere to line the 
drivetrain up on the other side.  
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168. Repeat steps 159-164 
to assemble the second 
drivetrain.  

 

Now that both drivetrain 
sub-assemblies are in place, 
we can add the bucket. 

169. Click  Assemble, 
then select bucket_sub.asm 
and place it next to the 
assembly. 

170. Use the Orientation 
Sphere to line the bucket up 
as shown.  
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171. Select the 
surfaces of the two 
holes shown to align 
them.  

 

172. Select the flat 
side of the drivetrain 
channel and the 
edge of the bucket 
channel to align 
them.  
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173. Select the bottom of the 
bucket channel and the top of the 
drivetrain channel to finish the 
assembly as shown.  

174. Click the green checkmark 

 to complete the placement. 

 

175. Test all of the moving 
parts by holding CTRL + 
ALT, left-clicking, and 
dragging to move them.  

  

 

176. Select File>Save to save your robot.  

177. From the Schools tab, click  Close. 

178. From the Home tab, Data group, click  Erase Not 
Displayed. Click OK to clear the session from memory. 

 
 

Congratulations! You have completed the assembly of your robot. 
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CREATING ASSEMBLY MODELS & BILLS OF MATERIALS 
 

 

The next step of the product development process involves preparing all 
the information necessary to produce the product. This includes drawings, 
manufacturing plans, assembly plans, and defining the bill of materials, 
which specifies all of the parts in a product. The bill of materials becomes 
an important document since it defines the product. The bill of materials 
is also used to define supply chains (the network of suppliers that will 
provide the parts for the product).  

 

Exploded Drawings & Bill of Materials 

Once a product assembly model has been created, an exploded drawing 
needs to be created to document the assembly. Part of the exploded 
drawing includes a table that lists all of the parts. This is called the Bill of 
Materials (BOM). Let’s start making a bill of materials for our PTC Robot 
model.  

Module 5: Production 
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179. Start PTC Creo Parametric 
by double-clicking on the icon 
or by going to the Start Menu, 
finding PTC Creo Parametric, 
and selecting it. 

         

180. From the Home tab, Data group, 

click  Select Working Directory. 

181. Navigate to your Digital 
Robotics folder: 

• Double-click the PTC_Robot 
folder. 

• Click OK. 

 

182. From the Home tab, click 

 Open:  

• Select ptc_robot.asm. 
• Click Open 
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183. From the In Graphics toolbar: 

• Click Datum Display Filters  and 
disable the display of all datum features. 

 

We need to create an exploded view 
drawing that will help us document all 
of the parts in our robot.  

184. From the Schools tab, click New 

: 

• Change the type of file to 
Drawing. 

• Type in “Assembly_plan” for the 
file name. 

185. Click OK. 
 

186. From the New Drawing dialog box, select Empty with 
format.  

187. Click Browse…  

 

85



188. Under Common Folders, 

select  Working Directory. 

189. Select a_format.frm and 
click Open. 

190. In the New Drawing dialog 
box, click OK.  

 

191. From the Layout tab, 

click  General View.  

192. Select No Combined 
State, then click OK.  

193. Click anywhere on the 
drawing to place the view of 
the robot.                 

 

We will only need the 
isometric view for the 
exploded drawing. 

194. In the Drawing View 
dialog box, select 
ISOMETRIC under Model 
view names. 

195. Click Apply.  
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196. From the Categories section, 
select Scale.  

197. Select Custom scale, then enter 
0.2.  

198. Click Apply to view the 
changes.  

199. If necessary, you can refresh the 

display by clicking  Repaint 
from the In Graphics toolbar:  

 

 

200. From the Categories section, select 
View States.  

201. Check the box next to Explode 
components in view.  

202. From the drop-down menu, select 
EXPLODE. 

203. Click Apply. 
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204. From the Categories section, select 
View Display.  

205. From the Display style drop-down 

menu, select  Shading With Edges.  

206. Click OK.  

 

You now have an exploded view of the 
PTC Robot on your drawing.   
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Creating a Bill of Materials (BOM) 
 

Now that the drawing has an exploded view of the assembly, we can add 
a bill of materials. Since PTC Creo knows all of the parts that have been 
assembled, the bill of materials can be created automatically. 

 

207. From the Table tab, select  
Table from File.  

 

208. Select bom.tbl and 
click Open.  
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209. The table will follow 
your cursor. Left-click 
to place it in the upper-
right corner.  

Notice that the BOM 
shows each part in the 
assembly, as well as the 
quantity of each.  

 

Once the bill of 
materials is in place, we 
need to add balloons 
that link the elements 
in the list to the parts in 
the view. 

                

 

210. From the Table tab, select  Create 
Balloons.  

211. From the drop-down menu, select 
Create Balloons – All. 

 

90



Notice that balloon tags have been 
added to the drawing. However, 
they still need to be placed in the 
proper positions. 

 

212. Left-click and drag each 
balloon so that they are all 
able to be read.   

213. Continue moving 
balloons until you are 
satisfied with the drawing.  
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214. Select File>Save to save your 
exploded drawing.  
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Let’s review what we have done in creating an assembly drawing and bill 
of materials: 

• Created a drawing (Steps 184-190) 
• Created a new view (Steps 191-193) 
• Edited view properties (Steps 194-206) 
• Created a bill of materials table (Steps 207-209) 
• Created balloons and edited their positions (Step 210-213) 
• Saved the drawing (Step 214) 

 

 
Congratulations! You have completed this module.  
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DEVELOPING FIELD SUPPORT PLANS & MODELS 

 

Another aspect of product development is developing and deploying 
product support plans that will insure your product is successful in the 
field. A key element of field support plans are Failure Modes and Effects 
Analyses (FMEA). This is where you brainstorm all the ways a system could 
fail and then identify how you will address each of the possible failures. 

 

FMEA 
Failure modes and effects analyses are used during the field support 
phase to help identify all the possible issues that might occur when the 
product is in the field, meaning when the product is being used by 
consumers. Once these issues are identified, then mitigation plans are 
developed and built into a single, cohesive field support plan. 

In this exercise we will explore the PTC Robot and identify possible failure 
modes. We will do this using the Annotations tools within Creo 
Parametric. Let’s begin building a field support plan by exploring all the 
different sub-systems of the robot in PTC Creo, identifying all the issues 
we can imagine, and then defining ways to mitigate each of the issues. 

Module 6: Field Support 
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215. Start PTC Creo Parametric 
by double-clicking on the icon 
or by going to the Start Menu, 
finding PTC Creo Parametric, 
and selecting it. 

         

216. From the Home tab, Data group, 

click  Select Working Directory. 

217. Navigate to your Digital 
Robotics folder: 

• Double-click the PTC_Robot 
folder. 

• Click OK. 

 

218. From the Home tab, click 

 Open:  

• Select 
field_support.asm. 

• Click Open 

 

219. From the In Graphics toolbar: 

• Click Datum Display Filters  and 
disable the display of all datum features. 
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220. Select the 
Annotate tab.  

Notice the model 
annotations 
describing possible 
issues.  

 

 

There are three model annotations shown on the PTC Robot. These are 
three possible areas of failure for which we will need to have solutions. 
You can also add your own annotations to the model to account for any 
issues you can think of. Let’s practice adding an annotation about the size 
of the bucket. It’s possible that we’ll need to pick up something that’s 
bigger than the bucket, so we want to have a plan for this.  

 

221. From the 
Annotate tab, open 
the drop-down 

menu under  
Note.  

222. Select Leader 
Note.  
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Let’s use the Leader Note to make an 
annotation about the bucket’s size.  

223. Left-click anywhere on the 
bucket to place the note’s leader 
(arrow).  

224. Middle-click in the space above 
the bucket to place the note.  

 

225. In the note text box, type “Issue 
5: Bucket may be too small for 
required load.” 

Press ENTER while typing to move the 
text to the second line.  
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If necessary, you can select the 
note and move it to a desired 
location. You can also resize it 
or move the leader.  

 

 

Once the potential issues in our robot are identified, the next step is to 
develop strategies for addressing each of the issues. Let’s pick one of the 
issues and develop a strategy for mitigating it. 

Let’s mitigate issue 3. If the motor doesn’t have enough power, the robot 
won’t move. A plan to mitigate this issue would be to either increase the 
voltage to the motor or replace it with a more powerful motor. To 
document this mitigation plan let’s add another note that connects to the 
issue 3 note. 
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226. Create a new Leader Note 
(Steps 221-222) and attach it to 
the motor.  

227. Middle-click to place the note 
above Issue 3.  

 

228. Type “Increase voltage to motor 
or replace with a stronger motor.” 

229. Left-click in the white space next to 
the note to accept the text.  

230. From the Format tab, change the 
text color to green.  

Make sure you have the note selected 
before attempting to change the text 
color.  
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231. Select File>Save to save the 
robot with the added annotations.  

 

 

A complete FMEA would require that all of the subsystems be fully 
documented with issues and mitigation plans for all of the issues. It is an 
exhaustive process but can mean the difference between having a 
successful product or a failure in the market place. 
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Review 
 
Let’s review what we have been able to do using Creo Parametric 
Annotations: 

• View pre-defined annotations (Steps 220) 
• Create a new leader note for an issue (Steps 221-225) 
• How to add a mitigation note (Steps 226-229) 
• Change the text color of a note (Steps 230) 

 

These capabilities make PTC Creo an important tool for documenting and 
illustrating parts and products for a variety of purposes. 

 

Congratulations! You have completed this module and the Creo 
Foundations chapter of the Digital Robotics curriculum!! 
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National Education Standards 

  

Solid  
Modeling 

for 
Robotics 

 

 

Model 
Analysis & 
Simulation 

 

Concept  
Design 

Next Generation Science Standards  
Cross Cutting Practices, Grades K-12 
Developing & Using Models 
 

X X X 

Planning & Carrying Out Investigations 
 

X X X 
Constructing Explanations & Designing Solutions 
 

 X X 

Obtaining, Evaluating, & Communicating Info 
 

 X  

Engineering, Core Ideas, Grades 6-8 
EST1.B Developing Possible Solutions 
 

  X 

Common Core Standards 
English Language Arts, Science & Technical Subjects, Grades 6-8 
CCSS.ELA-LITERACY.RST.6-8.3 
Follow precisely a multistep procedure when 
carrying out experiments, taking measurements, 
or performing technical tasks. 

X X X 

CCSS.ELA-LITERACY.RST.6-8.4 
Determine the meaning of symbols, key terms, 
and other domain-specific words and phrases as 
they are used in a specific scientific or technical 
context relevant to grades 6-8 texts and topics. 

X X X 

International Society for Technology Education  
Creativity and Innovation: Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
Apply existing knowledge to generate new ideas, 
products, or processes 

  X 
Use models and simulations to explore complex 
systems and issues 

X X X 
Technology operations and concepts: students demonstrate a sound understanding 
of technology concepts, systems, and operations. 
Understand and use technology systems X X X 
Select and use applications effectively 
and productively 

X X X 

Trouble shoot systems and applications 

 

X X X 
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Detailed  
Design 

 

Production 
 

Field 
Support 

 

Next Generation Science Standards  
Cross Cutting Practices, Grades K-12 
 
Developing & Using Models 
 

X X X 

Planning & Carrying Out Investigations 
 

X X X 
Constructing Explanations & Designing Solutions 
 

  X 

Obtaining, Evaluating, & Communicating Info 
 

X  X 

Engineering, Core Ideas, Grades 6-8 
 
EST1.B 
Developing Possible Solutions 

X X X 

Common Core Standards 
English Language Arts, Science & Technical Subjects, Grades 6-8 
 
CCSS.ELA-LITERACY.RST.6-8.3 
Follow precisely a multistep procedure when 
carrying out experiments, taking measurements, 
or performing technical tasks. 
 

X X X 

CCSS.ELA-LITERACY.RST.6-8.4 
Determine the meaning of symbols, key terms, 
and other domain-specific words and phrases as 
they are used in a specific scientific or technical 
context relevant to grades 6-8 texts and topics. 

X X X 

International Society for Technology Education  
Creativity and Innovation: Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
Apply existing knowledge to generate new ideas, 
products, or processes 

X X X 
Use models and simulations to explore complex 
systems and issues 

X X X 
Technology operations and concepts: students demonstrate a sound understanding 
of technology concepts, systems, and operations. 
Understand and use technology systems 

 

X X X 

Select and use applications effectively 
and productively 

X X X 

Trouble shoot systems and applications 

 

X X X 
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Introduction 

Creo Foundations 

Recon Robot 
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Image credit: iRobot 

Robots are used in many important situations. They can help doctors perform precise surgeries. 
Robots can quickly process large amounts of information and report back important patterns 
to warn cities about impending natural disasters., Robots can also take form as aerial drones 
that collect important information such as farm productivity or troop movements in military 
theatres. The possibilities truly are endless. 

Designing robots gives you the opportunity to learn and use many skills and important 
concepts. These can be helpful in science, technology, engineering, mathematics (STEM) fields 
as well as other disciplines such as computer science and the arts.  

In this project you will take on the role of a robot designer. In particular, you will focus on 
designing a search and rescue robot like the iRobot product above. To assist you with this 
experience, we will show you how to use various technologies (i.e. LEGO Mindstorms, EV3 
programming software, and PTC Creo design software) and industry strategies to build a 
functioning robot that can help people in emergency situations such as earthquakes, military 
zones, and catastrophic fires.   

Recon Robot Project 
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The Recon Robot project is broken down into three phases. This project is 
intended for beginners new to robot design and programming. Estimated 
Learning Time: 24-30 hours.  

 

 
  

Explore Phase 
The goal of this project phase is to become familiar with the 
design challenge, conduct research on robotics, build the 
base LEGO robot, and program it to follow a specific path. 
Estimated time: 8-10 hours 
 
 
 

 
 

Create Phase 
The goal of this project phase is to improve the base LEGO 
robot design by adding a sensor shell that protects the robot 
during disaster reconnaissance missions. This includes 
brainstorming ideas, modeling digital and physical 
components, field testing and a simulated customer 
demonstration. Estimated time: 8-10 hours 
 
 

 
 

Share Phase 
The goal of this project phase is to prepare the Recon Robot 
for field operations by creating a product logo, production 
documentation, a shipping crate, and a press release about 
the robot. Estimated time: 8-10 hours 
 
 
 

 

 

If you want to learn more about the Explore Create Share learning model, visit the PTC 
Creativity Lab: www.ptc.com/go/creativitylab  
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Recon Robot Project Modules 

 

Explore 
 

 

Create 
 

 

Share 
 

 

 
 

1. Get Started 
 

 

 
 

5. Sensor Shell Concept 

 

  
 

9. Product Logo 

 

 
 

2. Robot Research 
 

 

 
 

6. Shell Modeling  

 

 
 

10. Engineering Drawing  

 

 
 

3. Base Build  
 

 

 
 

7. Sensor Shell Testing  

 

 
 

11. Shipping Crate 

 

 
 

4. Robot Report 
 

 

 
 

8. Customer Demo 

 

 
 

12. Press Release 
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Explore Phase 

The goal of the Explore phase is to familiarize with the project challenge, 
learn about robot design, and build your base reconnaissance robot.  

 
 

 

Summary: The objective of this exercise is to familiarize with the project scenario, tasks, and 
materials.  

1a: Disaster Scenario  

An earthquake has struck a town! Buildings have collapsed and fires are burning everywhere. 
There are very toxic and potentially explosive chemicals located in a storage depot. The fumes 
from the burning chemicals and the threat of an explosion are keeping the local fire 
department from getting in to secure essential resources such as medical supplies and food. In 
order to prepare for entering the building, these firemen need to send in a reconnaissance 
robot to find the best route and locate the objects.  Your task is to design a prototype robot 
that can solve this reconnaissance problem.   

 

Module 1: Get Started  
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1b: Project Deliverables 

As you design and test your robot you will create several pieces of documentation. Below is 
each assignment or deliverable (this is a term used in industry) organized by the Explore Create 
Share process.  

 

1. Explore Phase 

• 3D Creo View Model with research notes 
• Physical Build of Base Recon Robot 
• Robot programmed to follow designated path  
• Quad Chart Research Summary 

 

2. Create Phase 

• 3-5 Sensor Shell Concepts 
• Performance Sketch of Sensor Shell 
• Physical Build of Sensor Shell 
• 3D Model of Sensor Shell 
• FMEA Report  

 
 

3. Share Phase 

• Product Logo 
• Engineering Drawing  
• Shipping Container Screen Shot  
• Press Release  
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1c: Project Materials 

This project requires design software, build materials and programming software. The total 
cost of this project is approximately $350/team of students. 

 

Design Software 

• PTC Creo files: http://apps.ptc.com/schools/curriculum/Beginner_Digital_Robotics_KOP.zip  
• PTC Creo Parametric: download in software section of www.ptck12.com  

Cost: free 
• PTC Creo View Desktop: download in software section of www.ptck12.com  

Cost: free 
• PTC Creo View Mobile: download in software section of www.ptck12.com  

Cost: free 
 

Design & Build Materials 

• LEGO Mindstorms EV3 Base Set: https://shop.education.lego.com/legoed/en-
US/search/navSearchResults.jsp?categoryId=EDU_PRD_LINE_107&ProductLine=MINDST
ORMS+Education+EV3  
Cost:$349.95 (Core Set)  

• EV3 User Guide: http://www.nr.edu/csc200/labs-ev3/ev3-user-guide-EN.pdf  
Cost: free 

 

Programming Materials 

• LEGO Mindstorms EV3 program: http://www.lego.com/en-
us/mindstorms/downloads/download-software  

• Cost: free 
 

Robot Testing Zone 

• Diagram included below 
• Cost: under $20 (craft/build materials) 
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Robot Testing Area: Reference 

• Black line is tape.  
• The circles are placement holders for debris and other objects.  
• When you get to the Create Phase, we recommend personalizing the course so there are 

various types of objects that need to be avoided.   
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Example Course Track 
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Summary: Explore robot systems and use PTC Creo View to preview your robot materials.  

 

2a: Robot Systems 

Introduction to Robotics 

Robots are some of the most complex systems ever created. They exist in many forms, from 
commercial vacuum cleaners to Mars rovers. Robots first became common in manufacturing 
during the late 20th century. Over time they have expanded into scientific, medical, defense, 
commercial and even recreation areas. 

 
Image credit: Boston Engineering Robot Tuna 

 

Recent growth in computing power has opened new possibilities for robots, ranging from 
simple to complex behaviors. For example, the Boston Engineering Robot Tuna above can 
swim like a tuna and collect information on water properties as it navigates water systems (e.g. 
chemicals, objects, nutrients, salinity).   

Module 2: Robot Research  
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All robots share key features. They include: (1) Control System, (2) Mechanical Components, (3) 
Sensor Components, and (4) Software. Let’s look closely at each of these subsystems and 
identify the purpose/function of each.  

Control System  

This is the system responsible for the intelligence of the robot. It is like the “brain” of the robot. 
This system stores and sends commands to and from various components such as motors and 
sensors. This is the system responsible for selecting a plan of action based on cues from the 
environment.  

 

Image credit: Doug Scott 

A simple way to identify a robot control system is to look for what looks like the heart of the 
robot. If every other component is connected to it (e.g. veins/arteries), then it typically is a 
major control system. 
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Mechanical Components 

The mechanical components enable the robot to act in its environment. They can be parts as 
simple as a light that turns on or off or as complex as mechanical limbs. These components 
receive signals from the control system.  
 

 
Image credit: iRobot 

Mechanisms range in variety. Common components include: motors, servos, and pneumatics or 
hydraulics which enable the mechanical devices to operate. For example, servos are used to 
rotate mechanical limbs. Mechanical components also include manipulators. These are moving 
parts that enable the robot to interact with the environment with devices such as a gripper, 
claw, or cutting tool. For example, the iRobot 710 Kobra above has a manipulator that enables 
the robot to pick up and move objects.   
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Sensor Components 

Sensor components can be defined as anything that sends a signal to the control system. 
Sensors can take many forms and include anything from touch sensors to radioactive particle 
detectors. The key concept here is that sensors are what make the robot aware of or “sense” its 
environment, and thus the sensors have a direct impact on how the robot will react to any 
given situation. 

 
Image credit: Doug Scott 

In the image above, the LEGO Mindstorms robot has a light sensor on its front that it uses to 
follow a line track. Based on color differences between the black tape and white floor, the 
robot uses program logic to follow the black tape outline. In this project, you will incorporate 
programming just like this!  
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Software  

Software (sometimes called code or programs) are the commands stored in the control system. 
Software dictates how the control system functions and by extension how every other 
component on the robot behaves. Robot software can be considered analogous to DNA; it is 
the code that dictates how the robot will behave and in some cases evolve.  

 
Image credit: Ryan Dailey 

Above is an example of software code used in the Mindstorms programming language. This 
programming uses an icon-based language that is especially helpful for beginner coders. As 
you advance in your computer programming skills you can take on more advanced coding 
languages such as ROBOTC, Java, Python or Ruby On Rails.  
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2b: Explore 3D Model using PTC Creo View (desktop/laptop) 

 

In this exercise you will view a 3D model of the Recon Robot. In addition, you will apply your knowledge 
of robot systems by adding digital notes to the 3D model.  

Let’s get started by opening PTC Creo View on your desktop/laptop computer.  

 

 
1. Launch PTC Creo View on your desktop or 

laptop computer. See the materials list above 
to find the download link for the software.  
 

2. Open the Recon_Robot_Base.pvz file from 
your project folder.  

 
3. Click the top check box in the model tree to 

make the parts visible.  
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4. Explore the model using your mouse and 

pay attention to the location of each 
subsystem in the model.  
 

5. Click on the Annotation Sets tab and then 
double click on the thumbnail titled 
Exploded View.  

 
6. The robot model will explode showing 

various internal and external parts.  
 

 

 
 
 
 
 
 

 

 

 
 

 

 

120



2c: Explore 3D Model using PTC Creo View (mobile) 

You can use your iPhone, iPad and other Apple devices to view 3D models of products. You 
can also show your friends and family the 3D products using your mobile device. 

Below we will provide directions on how to view 3D models on your iPhone. You can use the 
same directions for other mobile Apple devices such as an iPad.   

 

 

 
1. Download PTC Creo View Mobile app:  

 
2. Visit this link to download the Recon Robot 

Model:  
 
3. When you click the link you will get a 

request to select the app you want to use 
to open the model, select Open in Creo 
View 

 

4. Explore the model using your fingers (one 
finger rotates the model, two fingers 
spreading apart will zoom, and two fingers 
together will pan).   

 
 

 
 

 
5. You can check out an Exploded View of the 

model by touching the Views text in the 
top right corner of the app. 

  

6. You can also get a cool global exploded 
view by shaking the phone. Shake once to 
get the global explode, and shake again to 
return to the default view.  
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2d: 3D Annotated Robot Systems (requires desktop/laptop) 

In the desktop version of PTC Creo View you can add digital notes to 3D models and explore 
different view states such as an exploded view.  

In this exercise, the goal is to apply your knowledge of robot systems to mark up the 3D model 
with personalized notes. In particular, you will identify the (1) Control System, (2) Mechanical 
System, (3) and Sensor System on the Recon Robot Base. When you have finished adding 
digital notes, take a screen shot of your robot. You will use this later on in the project.  

 

1. Launch PTC Creo View (if not open already) 
 

2. Click the top check box in the model tree 
to make the parts visible (see prior step for 
check box location).  

 

3. Click on the Markup tab.  
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4. Click Note with Leader 
  

5. Left-click onto a spot associated with one 
of the robot subsystems (control, 
mechanical, sensor).   

 
6. In the Note pop-up window, type in the 

subsystem you selected. 
 
7. Click on the OK button.  
 

 

 

 
 

8. Save your notes, by selecting File, then 
Save Annotation Set, and then click on 
Save Annotation Set. Choose an 
annotation set name such as “Robot 
Systems”. 

 

 

 

 
 

9. If you close down Creo View and open the 
model at another time, you can see your 
annotation notes, by selecting the 
Annotation Sets near the model tree.  
 

10.  Now you have a 3D model with technical 
notes that identifies the subsystems of the 
Recon Robot.   

 
11. Add notes as you feel appropriate and that 

are aligned to your design goals.  
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Summary: In this module you will build the base physical robot and program the robot to 
follow a line.   

 

3a: Base Build of Robot 

In the LEGO Mindstorms kit of parts (KOP) there are instructions on how to build a basic robot. 
We will provide a few additional steps so you can create the Base Recon Robot.  

Additional instructions:  

 
Please use the EV3 instructions manual to build 
the basebot. In particular, follow the instructions 
on pages 7-38 to build the base recon robot.   

 
 
 
 
 
 
 

 

 

 
 

 
There are three small modifications we would like 
you to make in order to create the physical 
version of the Recon Robot Base.  
 

1. Remove the small axle pieces extending 
outward from the white angular piece, and 
then insert a 10-module axle piece in 
between the two angular pieces.  
 
 
 

 

 

 
 

Module 3: Base Build  
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2. Attach the color sensor to the 10-module 
axle piece.  
 

3. Once you have the color sensor attached 
to the axle, make sure the assembly is 
secure and then connect the sensor with 
the control module using a cable.  

 

 
 

Now that you have the color sensor attached to your base Recon Robot, it is time to program 
your robot so that it follows a set path. You will need to set up a test field to complete this next 
step of the project (see Module 1, Get Started).  

  

 

 

 

 

 

 

 

 

 

 

 

125



3b: Program Line Follow Code  

The EV3 Mindstorms robots can be programmed to perform a variety of functions. In this 
exercise, you will program the Recon Robot to follow a black line on the floor or large table. 
There are two options: (1) use the pre-coded line follow file we created and load it into your 
robot, or (2) create your own line follow code. Below are instructions for both approaches.  

 

 
1. To start, open the Lego 

Mindstorms program.  You 
should be greeted by this screen. 

2. If you have not downloaded it yet, 
here is the link: 
http://www.lego.com/en-
us/mindstorms/downloads/downl
oad-software 

 

 

 
 
 

3. Left click on “File” in the top left 
corner and select “New Project” 
by left clicking it. A new window 
will pop up. 

 

 
 
 

4. Now click on the orange- colored 
button at the bottom, The icons 
will change. 
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5. Left click on the loop icon (shown 
at right) 
 
Once selected you should be able 
to move the icon. 

 

 
 

6. Drag the loop icon next to the 
play icon so that they snap 
together 

 

 
 
 
 
 

7. At the bottom of the page, left 
click on the “Switch” to select it. 
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8. Drag the switch inside the loop 
by moving it and left clicking in 
the gray space created.  

 

 
 

9. Left click on the comparison 
button in the switch. 

 

 
 

10. Left click on “Color Sensor,” 
“Compare,” then “Reflected 
Light Intensity.” 
 
This is how we will use this to 
determine if a surface is bright or 
dark. 

 

 
 

11. At the bottom of the screen, click 
on the green rectangle. 
 
This will show the motor control 
icons.  
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12. Select the “Move Tank” function 

 

 
 

13. Place the Tile in the space at the 
top of the switch and drop it by 
clicking on the gray space.  

14. Repeat this process to put a Move 
Tank tile in the bottom slot of 
the switch. 

 

 
 

15. Click the large button on the left 
of the “Move Tank” tile to bring 
up this menu, left click on “On.”  

16. Repeat this process for the second 
“Move Tank” tile. 

 

 

 
 
 
 
 
 
 

17. Your Screen should now look like 
this: 
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18. Click on the number under the 
left gauge of the top “Move Tank” 
tile, type in -10, and hit enter. 
Then, click on the number under 
the right gauge and change that 
value to 30, press enter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

19.  Change the value under the left 
gauge of the bottom “Move 
Tank” tile to 30 and the one under 
the right gauge to -10. 
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20. Save the project by pressing the 
“File” button in the top left 
corner to bring up the menu. 

 

21.  Left Click on “Save Project As,” 
type the name in the File name 
bar, and click the “Save” button. 
  

22. In order to start the program, 
connect the robot to the 
computer with the included USB 
cable, and press the highlighted 
button to start the program 
sequence.  
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Summary: In this module you will create a quad chart that summarizes your research on 
robotics.  

4a: Quad Charts  

In industry a quick approach to report on a product’s development is a Quad Chart. A quad 
chart is a one page summary that organizes key information into four sections. This method is 
often used in military and government research and development (also referred to as R&D).    

 

  
 

 

4b: Robot Research 

Using a quad chart as an organizing tool, your goal is to summarize your research findings 
from earlier activities in the Explore phase (robot systems, Creo models, building, and 
programming).   

In the following page you will find a template quad chart to organize your experience.  

 

Module 4: Robot Report   
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Product Name 
 
 
 
 
Product Image (screen shot or photo of 
your robot) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Industry Robots (share at least 3 examples 
of robots used in industry) 
 
 
 
 
 
 
 
 
 

 
LEGO Build experience (list 2-3 
challenges and successes you had building the 
physical robot) 
 
 
 
 
 
 
 
 
 
 
 

 
Programming experience (list 2-3 
challenges and successes you had 
programming the robot to follow a line) 
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Create Phase 
The goal of the Create phase is to design a sensor shell that will protect your 
sensor system. 

 
 

 

Summary: The objective of this exercsie is to brainstorm potential designs for your sensor 
shell.  

5a: Sensor Shell Need  

Your recon robot is designed to operate in dangerous environments. As a result, it is essential 
that you protect important components of your robot.  

One component that is vulnerable is the color sensor in the front of the robot. Imagine if this 
sensor bumped into a sharp object or damaging material;if the color sensor brakes, the robot 
cannot move.  

In order to protect your critical color sensor, your objective is to build a sensor shell. This shell 
will protect the color sensor from damage caused by touching debris or foreign objects. 
Remember, if the color sensor touches any debris or foreign object(s), it will not be able to 
complete its reconnaissance mission.    

 

Module 5: Sensor Shell Concept  
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5b: Brainstorming Strategies 

You now have a new challenge: design the sensor shell for your reconnaissance robot. One 
step many designers use when beginning a new project is to brainstorm new ideas. In this step 
it is important to come up with many ideas and then pick a few ideas that you think are the 
best (e.g. easy to build, solves the problem, etc.).  

 

When brainstorming as a team, there are few helpful rules to follow:  

1. Don’t judge or make fun of people’s ideas. The purpose of brainstorming is to come up 
with as many ideas as possible. Sometimes the crazy or different ideas lead to new 
approaches that are very helpful in product design.  

2. Everybody needs to come up with ideas, and the more ideas, the better. If everyone on 
the team shares ideas, there will be more ideas to choose from in the end. 

3. After you generate many ideas, you can move on to the selection process where you 
vote or pick ideas based on the design requirements.  
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One way to help you brainstorm ideas for a protective shell is to look at how things in nature 
and technology protect themselves. Follow the steps below to facilitate this brainstorming 
process:  

Step 1: Observe organismal and technological examples in the references below and conduct 
your own research to expand on these references.  

Step 2: Create thumbnail sketches of at least three sensor shells that are inspired by the 
nature- and/or machine-based references.  

Step 3: Select 1-2 ideas that you think will best suit your robot design based on these two 
criteria: (a) can be created using the parts in the LEGO kits, and (b) protects the color sensor; in 
particular prevents any object/debris from touching the color sensor.   

 

Examples of protection strategies in nature 

 

 

 

 

 

 

 

 
 

Examples of protection strategies in the human built world 
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5c: Performance Sketch  

 

Now that you have selected several ideas it is time to move on and create a sketch or 
illustration of your robot and sensor shell design.  

This sketch will help you define the look and function of the robot. In industry, this piece of 
evidence is used as a design check-in where the designer gets feedback from his or her boss or 
the company that hired their design services.  

In industry, designers use both physical tools (e.g. pencils, markers) and digital tools (e.g. 
Adobe PhotoShop, Adobe Illustrator, etc.) to create concept sketches. In this exercise you will 
use pencils and other physical drawing tools to illustrate your sensor shell design. 
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In particular you will draw a performance sketch of your sensor shell in action. This sketch 
approach is similar to what you would see in a comic book where you see characters jumping 
off of buildings with colorful jump arrows. For example, in the image below you can see 
Mandarin’s ring is projecting a blast of energy that is hitting the Hulk—here, the “performance” 
is the ring shooting the blast of energy.  

 

 

Similar to the shoe or comic sketch you are going to create a performance sketch  illustrating 
how your sensor shell works. See the instructions below:  

 

Step 1: Draw your sensor shell.  

Step 2: Annotate the sketch to identify key features  

Step 3: Show how the sensor shell works by including movement diagrams and other visuals 
that show action (e.g. protecting the light sensor from danger).  
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Sketch tips: (1) label structures, geometry and other features (i.e. annotations), (2) use color 
highlights to identify important features on a product, and (3) draw multiple perspectives to 

show different functions of the product. 
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Summary: The objective of this module is to design the physical and digital version of your 
sensor shell.   

6a: Physical Sensor Shell Model   

Now that you have brainstormed and illustrated your sensor shell concepts, it is time to create 
physical models using LEGO Mindstorms materials. This design process is open-ended. Use 
your concept sketch and start tinkering with the LEGO parts!  

Keep in mind your design requirements:  

• The robot needs to follow a line 
• The sensor shell protects the color sensor 
• When operating in the field, the color sensor must not be touched by any objects; if 

contact is made this is considered a field failure and the product will have to be 
improved.   

 

 

Module 6: Shell Modeling  
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Now that you have built the physical version of your sensor shell, it is time to create the digital 
version of your robot.  

 

6b: Digital Sensor Shell Model    

After creating a sensor shell model with LEGO Mindstorms parts, you can create a 3D model of 
this design using PTC Creo Parametric. The benefits of 3D modeling in industry are:  

• You can quickly create digital drawings that you can share with manufacturers and other 
interested people (e.g. managers, customers, etc.).  

• You can use the digital image of your robot for marketing and other communications 
materials.  

• You can verify the quality of your robot by conducting virtual tests.  
• You can rapidly create a bill of materials that provides helpful information for pricing, 

material properties, and other resource topics.  
• You save the digital files for future engineering projects or share the data with 

engineering partners.  
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Assembly 

Let’s get started. Using PTC Creo Parametric you will create a digital model of your physical 
sensor shell on the Recon Robot base. The main tool you need is the assembly function.  

If you have not yet created assemblies in PTC Creo before, please review the Creo 
Foundations chapterof this Digital Robotics Curriculum.   

 

Most likely you will use a basic assembly with coincident or distant contstraints as well as a pin 
constraint if you want moving parts. Both of these assembly approaches can be found in the 
Creo Foundations chapter.  

 

Basic Assembly (e.g. coincident) 
 

 

Pin Assembly 
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Mass Properties  

It is important to know the basic properities of your robot such as volume and  mass as these 
items will impact cost (e.g. more weight requires more materials, which requires more money; 
or a heavy robot is expensive to ship). It is also important to verify that your robot is balanced 
when the sensor shell is attached to the robot. This can be verified by verifying the Center of 
Gravity (CoG) in PTC Creo.   

The example below uses a PITSCO Tetrix robot with a grabber mechanism. You can run the 
same steps using your 3D model of the LEGO Mindstorms robot.  

 

1. Launch PTC Creo Parametric.  
 

2. Set the Working Directory to your Rescue 
Robot Project folder.  

 
3. Open your recon robot assembly file.  

 
 
 
 

 

 
 
 

 
 

4. Select the Analysis tab and then click on 
Mass Properties.  
 

5. A small window will pop open, click 
Preview to run the Mass Properties 
analysis.  

 
6. The results will appear on the screen. 

Record the mass of your robot.  
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7. The next step is to identify the location of 
the Center of Gravity (CoG).  
 

8. In PTC Creo this is marked with the 1,2,3 
coordinate axis on the screen.  

 
 
 
 
 
 

 

 
 
 
Typically you want a CoG that is closer to the 
ground and centered in the middle of the robot. 
If the CoG is too far to the front there is a 
possibility that the robot will tip over.  
 
In the example to the right the CoG is good for 
both locations of the mechanism which provides 
the designer a degree of confidence that the 
robot will not tip over.  
 

 

 
 
 

 
 
 

 

With this information on center of gravity you can determine if your robot is too top heavy or 
favors one side of the robot. If there are problems, you can use this data to modify your design 
before programming.  

144



 

 
Summary: The objective of this module is to test your sensor shell performance and produce a 
report that identifies potential problems that could occur in the field.  

7a: Field Testing   

 

The goal of this exercise is to test how well your sensor shell functions. If the sensor is touched 
by any object in the disaster field, it must be considerd a failed operation. Based on your field 
testing observations make modifications to the sensor shell design. This process of improving a 
product based on data is called optimization.  

If you are looking to add different types of field obstacles, here are some options to consider:  

• Blocks 
• Markers/Erasers 
• Tape/Cans/Bowls 

 

• Hanging string 
• Plants 
• Furniture 

 

• Toys  
• Recycle materials 
• Books 

 

Module 7: Sensor Shell Testing  
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7b: Failure Modes and Effects Analysis    

FMEA introduction 

A Failure Modes and Effects Analysis (FMEA) is a critical step to ensure your product is 
supported in the field.  This is where you brainstorm all the ways a system could fail and then 
identify how you will address each of the possible failures. For example, in the image below is 
an aircraft with notes identifying possible failures that could take place while the plane is in 
operation.  

 

Any FMEA includes possible issues or problems and the accompanying solutions to solve the 
problem. For example, in your robot design a motor gear could burn out over time -  it would 
therefore be important for customers to have replacement motor gears available to service the 
product in the field.  
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FMEA documentation in PTC Creo  

In order to provide your customers with a visually appealing FMEA report, you are going to use 
PTC Creo View to create a 3D model that has annotations pointing to possible failures and 
associated solutions for your robot.  

In this example, we will use a different type of robot than what you are creating. In particular, 
we will continue to use the PITSCO Tetrix robot that is focused on grabbing objects.  

 

 
The first step is to convert your PTC Creo 
Parametric file into a format that is readable by 
PTC Creo View.  
 

1. Launch PTC Creo Parametric and open 
your recon robot assembly file.  
 

2. Select File, then select Save As, then Save 
a Copy 

 

3. In the pop up window, click the drop 
down in the Type area, and select Creo 
View (*.pvz) 

 
4. Name your FMEA file 
 
5. Click OK  
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Now you have a readable file format for PTC Creo 
View. It is time to open this file and label areas on 
the robot that you want to identify as possible 
problems, and the solutions you propose.  
 

6. Launch PTC Creo View  
 

7. Click the top check box in the model tree 
to make the parts visible  

 

8. Click on the Markup tab.  
 

 
 
 
 
 
 
 

 

 
 
 
 

9. Click Note with Leader 
  

10.  Left-click onto the location where you 
would like to identify possible 
issues/problems.   

 
11.  In the Note pop-up window, type in the 

problem and solution  
 
12.  Click on the OK button.  
 

 
At a minimum identify at least 3 potential 
problems/issues and associated solutions.  
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13. Save your notes, by selecting File, then 
Save Annotation Set, and then click on 
Save Annotation Set 
 

 

 
 

14. If you close down Creo View and open the 
model at another time, you can see your 
annotation notes, by selecting the 
Annotation Sets near the model tree.  
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Summary: The objective of this exercise is to demonstrate that your robot works as if you were 
presenting your design to a customer.  If possible, invite outside guests (school, community, 
business members, family, etc.) to observe the final run.  
 

 
Image credit: iRobot 

8a: Field Demonstration 

It is time to present your final prototype to a customer by conducting a field demonstration. 
This can be a real demonstration where you invite people from outside the class (e.g. school 
staff, community residents, business people, etc.) to be your audience, or it can be hypothetical 
or fictional where you pretend that the demo is the real thing. In a demonstration like this you 
only get one chance to show how well your robot works. Be sure you have tested it thoroughly 
beforehand!  

Requirements:  

• Robot completes line track follow 
• Robot includes sensor shell 

Module 8: Customer Demo  
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• Robot color sensor is not touched by debris/objects in the field 
• A final report/give-away that you deliver to the visitor/audience 

 

8b: Product Brief 

 

After your customer observes the demo, it is good practice to give them a take-away, 
something that summarizes your robot’s value and why they should consider using your 
design.  

There are many forms of a giveaway. For example, in industry this could be a pamphlet 
summarizing the robot features and performance, a website page covering similar information 
as in the portfolio, a video demo that the customer can look at later, or a 3D model that they 
can view on their phone using PTC Creo View Mobile.  

In this project we are going to show you how to make a product brief, one of the most 
commonly used tools for sharing a design. Pictured above is  a product brief for a water 
container that is inspired by the shape of the gourd fruit.  
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A product brief includes several features. One is a series of graphics that show the shape/form 
of the product such as dimensions, proportion, and configurations of parts. Another is a 
collection of notes that highlight key features of the product such as important robot systems. 
Also, a product brief my have a short summary paragraph that describes the purpose of the 
robot and its unique value in the market or field.  

 

When creating these product brief features it is important that your product brief is easy to 
read and is visually interesting.  

Tips:  

• We recommend incorporating graphics/screen shots from PTC Creo as well as your own 
illustrations and build design from previous steps in this project. 

• We recommend writing out the annotations on a separate piece of paper as a rough 
draft. Once you have the correct grammar and ideas you want to share you can add it to 
your final product brief document.  

• Product Briefs can be created using programs like Word or Google Docs or on physical 
sheets such as paper or poster paper.  
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Share Phase 
The goal of the Share phase is to complete industry role tasks that ensure 
your robot is succesful in the field or marketplace.  

 
 

 

Summary: The objective of this exercise is to take on the role of an artist/graphic designer and 
create a product logo for your recon robot.  
 

9a: Creating a Logo  

In industry companies have unique brands. A brand is the company’s identity, how people view 
the company in the world. The brand is influenced by the products the company makes, the 
company mission and motto, and other things that describe the company. Can you think of 
some popular companies and their brand such as McDonald’s (“I’m Lovin’ it”) or Apple 
(iProducts and the apple icon).  

One important element of a company brand is their logo. Sometimes logos take form as a 
graphic and in other cases it is just the name of the company in a stylized form, like the 
popular brands you likely recognize below.  

    

 

Module 9: Product Logo  
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In this exercise you get to play the role of an artist and design a logo for your company. When 
designing a company logo there are two important items to take into consideration:  

1. What is the one message you want to tell your customers that describes your 
organization? (for example: what is your company mission? what is your 
team/community identity? what do you love about this work?). 
 

2. What symbols, icons, imagery, text or colors best describe your company? 
 

 

For example, the PTC logo for the K12 organization is the icon below. The red represents 
industry and the green represents education, and in the middle the blue represents student 
innovation. Thus, our goal is to have industry and education work together or hand-in-hand to 
help students innovate.  

 

 

 

Instructions:  

Step 1: Identify your message 

Step 2: Create a logo that captures your message 

Step 3: Select logo color(s) that match your company message  

Step 4: Draw the final version of your icon and write 2-3 sentences describing why you chose 
this logo.  
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Summary: The objective of this exercise is to create a comprehensive list of the parts that 
make up your rescue robot and sensor shell.  

 
10a: Generate BOM 

A Bill of Materials (BOM) lists all the essential parts or components that are required to make a 
specific product. PTC Creo enables designers to quickly create a BOM using the engineering 
drawing feature.  

Your goal is to create a BOM for your unique rescue robot.  

 

1. Launch PTC Creo Parametric.  
 

2. Set the Working Directory to your Rescue 
Robot project folder.  

 
3. Open your final robot assembly file 

with the unique color sensor shell.  In 
this example we used the base recon 
robot file to demonstrate how this works.   

 

 

 
 

Module 10: Engineering Drawing  
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4. From the Schools tab, click New : 

a. Change the type of file to 
Drawing. 

b. Type in “Recon_BOM” for the file 
name. 

5. Click OK. 
 

 

 
 

 
 

6. From the New Drawing dialog box, select 
Empty with format.  

7. Click Browse… 
 
 
 
 
 
 
 
 

 
 

 
 

 

8. Under Common Folders, select  
Working Directory. 

9. Select a_format.frm and click Open. 

10. In the New Drawing dialog box, click OK. 
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11. From the Layout tab, click  General 

View.  

12. Select No Combined State, then click OK.  

13. Click anywhere on the drawing to place 
the view of the robot.                 

 
 

 

 

 
We will only need the isometric view for the 
exploded drawing. 

14. In the Drawing View dialog box, select a 
view that you want. For example, we 
chose BACK.  
 

15. Click Apply  
 

 

 
 

 

16. From the Categories section, select Scale.  

17. Select Custom scale, then enter 0.4.  

18. Click Apply to view the changes.  

19. If necessary, you can refresh the display 

by clicking  Repaint from the In 
Graphics toolbar:  

20.  
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21. From the Categories section, select View 
States.  

22. Check the box next to Explode 
components in view.  

23. From the drop-down menu, select 
EXPLODE. 

24. Click Apply. 
 
 
 

 

 

 

25. From the Categories section, select View 
Display.  

26. From the Display style drop-down menu, 

select  Shading With Edges.  
27. Click OK. 

 
 
 

 

 
 

 
28. You now will have an exploded view of 

your Recon robot on the engineering 
drawing.  Your next step is to add the 
BOM information to this drawing.  

 

 
 

158



 
Since PTC Creo knows all of the parts that have 
been assembled, the bill of materials can be 
created automatically. 
 

29. From the Table tab, select  Table 
from File. 

 
 

 

 

 
30. Select bom.tbl and click Open. 

 

 

 
 

 
31. The table will follow your cursor. Left-click 

to place it in a location of your choice.  
 
Notice that the BOM shows each part in the 
assembly, as well as the quantity of each. 
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Once the bill of materials is in place, we need 
to add balloons that link the elements in the 
list to the parts in the view. 

32. From the Table tab, select  Create 
Balloons.  

33. From the drop-down menu, select Create 
Balloons – All. 

 

 

Notice that balloon tags have been added to 
the drawing. However, they still need to be 
placed in the proper positions. 

 

 

 

 
 

34. Left-click and drag each balloon so that 
they are all able to be read.   

35. Continue moving balloons until you are 
satisfied with the drawing. 

36. You can also add notes to the Description 
column by double clicking the cells in the 
column.  

37. Select File>Save to save your exploded 
drawing. 
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Summary: The objective of this exercise is to prepare your robot for placement in a shipping 
container.  

 

11a: Determine Robot Dimensions 

The first step in designing your shipping container is to determine the dimensions of your 
recon rebot. This information will enable you to modify the shipping container your company 
uses to ship robots to customers. Using PTC Creo you can quickly determine this geometry. To 
demonstrate this in practice we will use the demonstation robot from the PITSCO Tetrix kit. 
You can follow the same directions using your robot.  

 

1. Launch PTC Creo Parametric.  
 

2. Set the Working Directory to your 
Rescue Robot project folder 

 
3. Open your robot assembly file.  

 
 
 
 
 

 
 

                  

Module 11: Shipping Crate 
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4. Select the Analysis tab, and then select 
the Measure drop down arrow and 
select Distance.  
 

5. Using your mouse click on an edge, 
surface, or point on the robot while 
holding the control button on the 
keyboard and select another feature to 
get the distance between these two 
features.  

 
6. Repeat this step for all essential 

dimensions (e.g. height, length, width) 
 
7. Now you have the area dimensions that 

will inform the design of your shipping 
container. For instance, the 
measurements for the base recon robot 
is approximately 201mm X 152mm X 
128mm 

 
 
 
 
 
 
 
 
 
 

 
LENGTH 

 
 
 
 

WIDTH 

 
 
 

HEIGHT 

 
 
 

 

This dimension data will be helpful when you prepare the robot for the shipping crate.  
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13b: 3D Model of Shipping Container 

Now that you have the area dimensions for your robot, you can modify a 3D dimensional 
model of the shipping container so it fits correctly. Below are some basic steps for getting 
started.  

 

1. Launch PTC Creo Parametric. 
 

2. Set the Working Directory to your 
Rescue Robot project folder 

 
3. Open the “shipping_crate.asm” file.  
 

 
 

 
 

 
 

4. Some of the parts are set up to move.  
 

5. While holding the Ctrl and Alt buttons 
left-click on the crate top and open the 
top to look inside.  

 
6. Your goal is to place your unique robot 

into the crate and modify the crate 
dimensions so it fits correctly. 

 

 
 

7. Click the assemble button and open your 
recon robot with its unique sensor shell 
design.  
 

8.  Orient your robot so it is aligned 
appropriately by moving the spin center 
arrows.  
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9. Constrain a bottom surface of your robot 
to the top surface of the crate bottom 

 
 
 

 

 
 

 
 

10. Constrain a front surface of your robot to 
the inner surface of the side of the crate. 

 
 

 

 
 

 

11. Constrain a side surface of your robot to 
the inner surface of the side of the crate.  
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12.  Now your robot will have three assembly 
constraints so you can click the green 
arrow to complete the assembly. 

 
 

 

 
 

 
 

13.  If there are spacing issues with your 
robot, you can modify the dimensions of 
the gray foam inside the crate. For 
example, in the screen shot to the right, 
you can see that the color sensor is 
inside the gray foam.  

 

 
 

 

14.  To fix this, open the “CRATE_FOAM.prt” 
file by right-clicking on 
“CRATE_FOAM.prt” in the Model tree and 
selecting “Open” from the drop-down 
menu that appears.  
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15.  When the “CRATE_FOAM.prt” is open 
you can edit the dimension of Extrude 2 
to change the inner dimensions. 
 

16.  Left-click on Extrude 2 and select the 
Edit tool which looks like a pencil over a 
small ball.  
  

 

 

 

 
 

17.  Double-click on any dimension you want 
to change in order to modify the foam 
shape.  

 
 

 

 
 
 

 

18.  Now go back to the 
“SHIPPING_CRATE.ASM” file and click 
regenerate to update the file.  
 

19.  Now your model should be updated. 
 
20.  You can modify other parts of the crate 

by following procedures similar to the 
previous steps.   
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Summary: The objective of this exercise is to write a press release that announces how well 
your product worked.   

 
12a: Writing Process  

In this exercise you are going to pretend that the final demos you did in the Detailed Design 
phase were actually real-life situations and you need to describe how well your robot did. You 
will present this story by writing a press release. A press release is a standard format for 
announcing new innovations in a company.  

 

Instructions:  

When you write your press release announcing what happened in your fictional food rescue 
(based on your final demo), you should consider several items:  

• Story/Narrative: Describe what happened in the fictional scenario of removing essential 
food from a burning building.  
 

Module 12: Press Release  
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• Engaging title: Engage your audience with a short, snappy title that summarizes the 
outcome of the final demo 
 

• Header Image: Create an image that conveys the message of your story 
 

• Author credits: Include all authors on the document.   
 

• Edits: Don’t forget to check for grammar and readability.  
 

 
Student example 
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Additional Resources  

 
The PTC K12 Program offers a variety of resources to support students and educators 
interested in design, STEM education, and innovation. Learn more at the following sites:  
 

• PTC K12 Program: www.ptck12.com  
 

• PTC FIRST: www.ptc.com/go/first 
 
• PTC STARBASE resources: www.ptc.com/go/starbase  
 
• PTC Creativity Lab: www.ptc.com/go/creativitylab   
 
• PTC STEM Certificate Program: www.stemcertificate.org  
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NATIONAL EDUCATION STANDARDS  
 

EXPLORE PHASE 
 

Get  
Started 

 

 

Robot 
Research 

 

Base  
Build 

 

Robot  
Brief 

Next Generation Science Standards  
Cross Cutting Practices, Grades K-12 
Asking Questions & Defining Problems 
 

X X   

Developing & Using Models 
 

  X  

Planning & Carrying Out Investigations 
 

X  X  

Analyzing & Interpreting Data    X 
 

 

Using Mathematics and Computational 
Thinking 

  X 
 

 

Constructing Explanations & Designing 
Solutions 
 

X X X X 

Engaging in argument from evidence  
 

   X 

Obtaining, Evaluating, & Communicating 
Info  

 X  X 

Engineering, Core Ideas, Grades 6-8 
EST1.A  
Defining & Deliminating Engineering 
Problems 

X    

EST1.B 
Developing Possible Solutions 

  X  

Common Core Standards 
English Language Arts, Writing, Grades 6-8 
CCSS.ELA-LITERACY.WHST.6-8.1.  
Write arguments focused on discipline-
specific content. 

    
X 

CCSS.ELA-LITERACY.WHST.6-8.2:  
Write informative/explanatory texts, 
including the narration of historical 
events, scientific procedures/ 
experiments, or technical processes. 

  
X 

  
X 

CCSS.ELA-LITERACY.WHST.6-8.4:  
Produce clear and coherent writing in 
which the development, organization, and 
style are appropriate to task, purpose, 
and audience. 

    
X 

CCSS.ELA-LITERACY.WHST.6-8.7:  
Conduct short research projects to 
answer a question (including a self-
generated question), drawing on several 
sources and generating additional related, 
focused questions that allow for multiple 
avenues of exploration. 

 
X 

 
X 

 
X 

 
X 

CCSS.ELA-LITERACY.WHST.6-8.9 
Draw evidence from informational texts to 
support analysis, reflection, and research. 
 

  
X 

 
X 

 
X 
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EXPLORE PHASE 
 

Get  
Started 

 

 

Robot 
Research 

 

Build & 
Program 

 

Robot  
Brief 

Common Core Standards 
English Language Arts, Science & Technical Subjects, Grades 6-8 
CCSS.ELA-LITERACY.RST.6-8.1 
Cite specific textual evidence to support 
analysis of science and technical texts. 

    
X 

CCSS.ELA-LITERACY.RST.6-8.3 
Follow precisely a multistep procedure 
when carrying out experiments, taking 
measurements, or performing technical 
tasks. 

   
X 

 

CCSS.ELA-LITERACY.RST.6-8.4 
Determine the meaning of symbols, key 
terms, and other domain-specific words 
and phrases as they are used in a specific 
scientific or technical context relevant 
to grades 6-8 texts and topics. 

 
X 

 
X 

 
X 

 
X 

CCSS.ELA-LITERACY.RST.6-8.7 
Integrate quantitative or technical 
information expressed in words in a text 
with a version of that information 
expressed visually  

  
X 

 
 

 
X 

International Society for Technology Education  
Creativity and Innovation: Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
Use models and simulations to explore 
complex systems and issues 

 X X  
 

Identify trends and forecast possibilities 
 

 X  X 

Communication & Collaboration: Students use digital media and environments to communicate 
and work collaboratively, including at a distance, to support individual learning and contribute to the 
learning of others. 

Communicate information and ideas 
effectively to multiple audiences using a 
variety of media and formats 

    
X 

Contribute to project teams to produce 
original works or solve problems 

X X X X 

Research and information fluency: Students apply digital tools to gather, evaluate, and use information. 

Plan strategies to guide inquiry X   X 
Evaluate and select information sources 
and digital tools based on the 
appropriateness to specific tasks 

 X X  

Critical thinking, problem solving, and decision making: Students use critical thinking skills to plan and 
conduct research, manage projects, solve problems, and make informed decisions using appropriate digital tools and 
resources. 
Identify and define authentic 
problems and significant questions for 
investigation 

X    

Plan and manage activities to develop a 
solution or complete a project 
 
 

X  X X 
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Next Generation Science Standards  
Cross Cutting Practices, Grades K-12 
Developing & Using Models 
 

X X X X 

Planning & Carrying Out Investigations 
 

X X X X 

Analyzing & Interpreting Data  
 

  X  

Using Mathematics and Computational 
Thinking  

  X X 

Constructing Explanations and Designing 
Solutions 

X   X 

Engaging in Argument from Evidence  
 

  X X 

Obtaining, Evaluating, & Communicating 
Info  
 

  X X 

Engineering,  Grades 6-8 
EST1.A  
Defining & Deliminating Engineering 
Problems 
 

 
X 

 
X 

  

EST1.B 
Developing Possible Solutions 
 

 
X 

 
X 

 
X 

 
X 

ETS1C 
Optimizing the Design Solution 
 

 
X 

 
X 

 
X 

 

Physical Science, Grades 6-8     
PS2-2 
Plan an investigation to provide evidence 
that changes in an object’s motion 
depends on the sum of forces on the 
object and the mass of the object.  

   
X 

 

Common Core Standards 
English Language Arts, Writing, Grades 6-8 
CCSS.ELA-LITERACY.WHST.6-8.1.  
Write arguments focused on discipline-
specific content. 

    
X 

CCSS.ELA-LITERACY.WHST.6-8.4:  
Produce clear and coherent writing in 
which the development, organization, 
and style are appropriate to task, 
purpose, and audience. 
 

    
X 

CCSS.ELA-LITERACY.WHST.6-8.7:  
Conduct short research projects to 
answer a question (including a self-
generated question), drawing on several 
sources and generating additional 
related, focused questions that allow for 
multiple avenues of exploration. 
 

 
X 

 
X 

 
X 

 
X 
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Common Core Standards 

English Language Arts, Science & Technical Subjects, Grades 6-8 

CCSS.ELA-LITERACY.RST.6-8.3 
Follow precisely a multistep procedure 
when carrying out experiments, taking 
measurements, or performing technical 
tasks. 

 
X 

 
X 

 
X 

 
 

CCSS.ELA-LITERACY.RST.6-8.4 
Determine the meaning of symbols, key 
terms, and other domain-specific words 
and phrases as they are used in a 
specific scientific or technical context 
relevant to grades 6-8 texts and topics. 

 
X 

 
X 
 

 
X 

 
X 

CCSS.ELA-LITERACY.RST.6-8.7 
Integrate quantitative or technical 
information expressed in words in a text 
with a version of that information 
expressed visually  

   
X 

 
X 

National Visual Arts Standards  
Creating, Anchor Standards 
Generate and conceptualize artistic ideas 
and work 

X    

Organize and develop artistic ideas and 
work 
 

X    

Refine and complete artistic wok X 
 

   

Performing/Presenting/Producing, Anchor Standard 
Convey meaning through the 
presentation of artistic work 

X   X 

Connecting, Anchor Standard 
Relate artistic ideas and works with 
societal, cultural, and historical context 
to deepen understanding 

X    

International Society for Technology Education  
Creativity and Innovation: Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
Apply existing knowledge to generate 
new ideas, products, or processes  

X X X X 

Use models and simulations to explore 
complex systems and issues 

  X  

Communication & Collaboration: Students use digital media and environments to communicate 
and work collaboratively, including at a distance, to support individual learning and contribute to the 
learning of others. 
Communicate information and ideas 
effectively to multiple audiences using a 
variety of media and formats 

X X  X 

Contribute to project teams to produce 
original works or solve problems 

 
 

X 
 

X X X 
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International Society for Technology Education  

Critical thinking, problem solving, and decision making: Students use critical thinking skills to plan and 
conduct research, manage projects, solve problems, and make informed decisions using appropriate digital tools and 
resources. 
Plan and manage activities to develop a 
solution or complete a project 

X 
 

X 
 

X 
 

 

Collect and analyze data to identify 
solutions and/or make informed decisions 

  X 
 

 

Use multiple processes and diverse 
perspectives to explore alternate 
solutions 

X 
 

X 
 

  

Technology operations and concepts: students demonstrate a sound understanding 
of technology concepts, systems, and operations. 
Understand and use technology systems X 

 
X 
 

X 
 

X 
 

Select and use applications 
effectively and productively 

 X 
 

X 
 

X 
 

Trouble shoot systems and 
applications 

  X 
 

 

Transfer current knowledge to learning of 
new technologies  

X 
 

X 
 

X 
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Next Generation Science Standards  
Cross Cutting Practices, Grades K-12 
Asking Questions & Defining Problems 
 

X  X  

Developing & Using Models 
 

 X X  

Planning & Carrying Out Investigations 
 

X   X 

Analyzing & Interpreting Data    
 

X  

Using Mathematics and Computational 
Thinking 

 X X  

Constructing Explanations & Designing 
Solutions 
 

  X  

Obtaining, Evaluating, & Communicating 
Info  
 

X X X X 

Engineering,  Grades 6-8 
EST1.A Defining & Deliminating 
Engineering Problems 

  X  

EST1.B Developing Possible Solutions 
 

 X X  

ETS1C Optimizing the Design Solution 
 

  X  
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Common Core  
English Language Arts, Writing, Grades 6-8 
CCSS.ELA-LITERACY.WHST.6-8.1.  
Write arguments focused on discipline-
specific content. 

   X 

CCSS.ELA-LITERACY.WHST.6-8.4:  
Produce clear and coherent writing in 
which the development, organization, 
and style are appropriate to task, 
purpose, and audience. 
 

X   X 

CCSS.ELA-LITERACY.WHST.6-8.7:  
Conduct short research projects to 
answer a question (including a self-
generated question), drawing on several 
sources and generating additional 
related, focused questions that allow for 
multiple avenues of exploration. 

X X X X 

English Language Arts, Science & Technical Subjects, Grades 6-8 
CCSS.ELA-LITERACY.RST.6-8.3 
Follow precisely a multistep procedure 
when carrying out experiments, taking 
measurements, or performing technical 
tasks. 

X X X  

CCSS.ELA-LITERACY.RST.6-8.4 
Determine the meaning of symbols, key 
terms, and other domain-specific words 
and phrases as they are used in a 
specific scientific or technical context 
relevant to grades 6-8 texts and topics. 

X X X  

CCSS.ELA-LITERACY.RST.6-8.7 
Integrate quantitative or technical 
information expressed in words in a text 
with a version of that information 
expressed visually. 

   X 

National Visual Arts Standards 
Creating, Anchor Standards 
Generate and conceptualize artistic ideas 
and work 
 

X    

Organize and develop artistic ideas and 
work 
 
 

X    

Refine and complete artistic wok 
 
 

X    

Performing/Presenting/Producing, Anchor Standard 
Develop and refine artistic work for 
presentation.  
 

X    

Convey meaning through the 
presentation of artistic work 
 

X    
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International Society for Technology Education  
Creativity and Innovation: Students demonstrate creative thinking, construct knowledge, and 
develop innovative products and processes using technology. 
Apply existing knowledge to generate 
new ideas, products, or processes  

X X X X 

Use models and simulations to explore 
complex systems and issues 

 X X  

Communication & Collaboration: Students use digital media and environments to communicate 
and work collaboratively, including at a distance, to support individual learning and contribute to the 
learning of others. 
Communicate information and ideas 
effectively to multiple audiences using a 
variety of media and formats 

X   X 

Contribute to project teams to produce 
original works or solve problems 

X X X X 

Research and information fluency: Students apply digital tools to gather, evaluate, and use information. 
Plan strategies to guide inquiry 

 

X  X X 

Evaluate and select information sources 
and digital tools based on the 
appropriateness to specific tasks 

X X X X 

International Society for Technology Education  

Critical thinking, problem solving, and decision making: Students use critical thinking skills to plan and 
conduct research, manage projects, solve problems, and make informed decisions using appropriate digital tools and 
resources. 
Plan and manage activities to develop a 
solution or complete a project 

X X X X 

Collect and analyze data to identify 
solutions and/or make informed decisions 

X   X 

Use multiple processes and diverse 
perspectives to explore alternate 
solutions 

   X 

Technology operations and concepts: students demonstrate a sound understanding 
of technology concepts, systems, and operations. 
Understand and use technology systems 

 

 X X  

Select and use applications 
effectively and productively 

X X X X 

Trouble shoot systems and 
applications 

 X X  

Transfer current knowledge to learning of 
new technologies  

X X X X 
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Additional Resources  

 
The PTC K12 Program offers a variety of resources to support students and educators 
interested in design, STEM education, and innovation. Learn more at the following sites:  
 

• PTC K12 Program: www.ptck12.com  
 

• PTC FIRST: www.ptc.com/go/first 
 
• PTC STARBASE resources: www.ptc.com/go/starbase  
 
• PTC Creativity Lab: www.ptc.com/go/creativitylab   
 
• PTC STEM Certificate Program: www.stemcertificate.org  
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